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Achieve 
Jurassic World 

quality 
page 40

Jay Howse explains his incredible
approach to realism Page 41

  Posing the model is 
very important and can 
transform a plain sculpt 
into something lifelike 
and believable  

Jay Howse
artstation.com/artist/
jay_howse

Software Maya, Mudbox, 
Photoshop



Welcome to 3D Artist! It has

been nearly 22 years since

Jurassic Park was let loose upon

audiences, capturing hearts and

minds with its stunning visual

effects. The VFX world has

evolved significantly since then

but many principles and

approaches remained, and now

we’re faced with a new beast under the same banner

– Jurassic World. In honour of its impending release,

we’ve brought you an incredible dinosaur tutorial from

Jay Howse to unleash your Maya potential.

Elsewhere in the mag we’ve been blessed with an

animation masterclass courtesy of Pixar senior

animator Robb Denovan, in which he reveals the

legendary studio’s approach to the art of bringing

timeless characters to life. It’s great to have Robb on

board, and his feature starts over on p34.

And of course we’ve the usually bevy of incredible

tutorials from some of the best in the business. I’m

extremely pleased to welcome Scott Eaton back to the

mag on p62, we’ve got the second part of Morro

Images’ modular backgrounds tutorial, Aldo Vicente

returns with a steampunk blowout and Gustavo Åhlén

gets industrial in SOLIDWORKS.

Plus, discover the 90 plugins, apps and hacks that

will change your workflow forever on p24!

Steve Holmes, Deputy Editor
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The 12 rules of animation 
at Pixar Page 34
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3dartist@imagine-publishing.co.ukGet in touch... Facebook.com/3DArtistMagazine@3DArtist

To the magazine and 100 pages of amazing 3D
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This issue’s team of pro artists…

JAY HOWSE
artstation.com/artist/jay_howse

Jay is responsible for our incredible cover

image and shows you how to create your 

own realistic, terrifying dinosaur over on 

p40. Learn how to achieve Jurassic World
quality in your work! 

3DArtist online username Jay Howse

CHRISTIAN RESKI
morroimages.com

In the second part of our modular 

backgrounds tutorial from Morro Images,

Christian reveals his texturing secrets in 

MARI. Don’t forget to download the 

assets from both parts from FileSilo now!

3DArtist online username n/a

SETH
www.sethnash.com

Seth is a brilliant character artist and 

often works in videogames. We asked 

him to take a look at one of the best tools

for games, the new Substance Designer. 

His expert review is over on p82. 

3DArtist online username n/a

ALDO VICENTE
aldovicentecg.com

We were really keen to get some more 

steampunk stuff  in the mag after our 

Blender tutorial in issue 78, and so we got

Aldo on the case. Check out his amazing 

insight starting on p46. 

3DArtist online username AldoVicenteCG

GUSTAVO
gustavoahlen.deviantart.com

This issue, Gustavo has dived into 

SOLIDWORKS to explore some crucial 

industrial design techniques and CAD 

principles. His extremely useful tutorial 

begins on p70. 

3DArtist online username gustavoahlen

PAUL CHAMPION
ncca.bournemouth.ac.uk

Paul is back, but rather than eff ortlessly 

breezing through the most technical of 

compositing tutorials, he’s taken a critical

look at Maya 2016. Find out what he 

thought of the new features on p74. 

3DArtist online username n/a

SCOTT EATON
scott-eaton.com

We feel extremely lucky to be able to 

welcome anatomy master Scott Eaton 

back to 3D Artist. This issue he shows 

you the ins and outs of totally accurate 

facial anatomy on p62. 

3DArtist online username n/a

ROBB DENOVAN
pixar.com

We’re privileged to welcome Robb to the 

magazine this month. Head to p34 to 

read his key priciples for animation, 

honed over a long, fruitful time in the 

industry at companies like Pixar. 

3DArtist online username n/a

DARIJAN KALAUZOVIĆ
behance.net/Darijan_kal

Autodesk’s other baby, 3ds Max, has 

recently enjoyed a substantial update for 

2016 as well. Join Darijan on p76 as he 

meticulously picks apart the latest 

features and reveals his verdict. 

3DArtist online username n/a
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90 Plugins, 
hacksandapps

News, reviews 
& features 

 10  Reader Survey
 Want to shape 3D Artist and meet the 
team? Fill in our survey to be in with a 
chance of making that happen

 14  The Gallery
 A hand-picked collection of incredible 
artwork to inspire you

 24  90 Plugins, hacks and apps
 Upgrade your CG projects with our 90 
must-know, essential add-ons to 3ds Max, 
Maya, ZBrush and more!

 32   Technique focus: Kangaroo Mech
Gavriil Klimov shows off  his impressive 
mech model and describes how he used 
his favourite programs 

 34  Pixar: 12 Rules of animation 
The renowned studio’s senior animator, 
Robb Denovan, reveals his secret 
animation techniques in detail 

 74  Review: Maya 2016
 Paul Champion analyses the performance 
enhancements and the core features in 
Autodesk’s latest Maya release

 76  Review: 3ds Max 2016
 Darijan Kalauzović evaluates the “Biggest 
Max Ever” and its new and improved tools

  78  Subscribe today!
Save money and never miss an issue by 
picking up a subscription

 80  Review: Overclockers RENDA 
PW-E7F
 Orestis Bastounis explains how this 
eight-core system from Overclockers will 
fare in the workstation market

 82  Review: Substance Designer 5
 Explore the fi fth release of the node-
based texture tool as Seth Nash takes 
assets through the software’s workfl ow 

 84  Review: iClone 6
 Does removing the process of rigging and 
object creation lead to a better animation
tool? Rebekka Hearl tells all

85 Review: Écorché assistant
We examine how much easier this app
will make anatomy studies

85 Review: Figuromo
Our verdict on the app collection that
introduces painting 3D models to children

Modular background 
buildings in 
Maya (Part 2)

Master facial 
anatomy

RobWatkinson one of his favourite render plugins Page 29

SAVE 40%
SUBSCRIBE TODAY

Turn to
page 78
for details

 What I enjoy most about V-Ray in particular is its 
simplicity for getting great lighting quickly.  

24

54 62
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RobbDenovanon animating with Pixar Page 36

The Pipeline
 40  Step by step: Resurrect a 

realistic Velociraptor
 Discover how to model and texture 
a Velociraptor, perfect for cloning

 46   Step by step: Texture distinct 
steampunk characters
Discover the expert techniques for 
making a steampunk engineer and 
his mechanical guardian 

 54  Step by step: Modular 
background buildings in Maya 
 Christian Reski brings you the fi nal 
chapter of our two-part complex 
modular technique tutorial

 62   Step by step: Master 
facial anatomy
 Scott Eaton teaches you the 
fundamentals of an écorché face 
study in ZBrush 

 70   Pipeline techniques: Model 
industrial designs
 Upgrade your product design 
projects with SOLIDWORKS

The Hub
 88  Community news

Product designers Bill Gould and 
Brian Yingling explain how they 
printed cars worth $40,000 in 3D

 90   Industry news
 Software releases galore! With 
Maya 2016, 3ds Max 2016, MODO 
901 and free NUKE at the helm 

 92     Industry insider 
David Helgason
 Unity Technologies’ co-founder 
expresses his excitement for the 
indie game industry 

 94  Readers’ gallery 
The 3DArtistOnline.com’s 
community art showcase

Resurrect a 
Velociraptor

3D printing 
$40,000 cars

Texture distinct 
steampunk characters

Over four hours of Digital
Tutors Maya video tuition
Premium CGAxis models
Smartphone models from
Humster3D
25 Incredible textures
courtesy of 3DTotal

Turn topage96 for the complete
list of this issue’s freedownloads

Strong posing can also tell us a lot
about the physicality of a character  

fi lesilo.co.uk/3dartist

DOWNLOADFROM THE

Visit the 3D Artist online shop at

for back issues, books and merchandise

88

34
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Joinour

SteveHolmes
Deputy Editor

ReaderPanel
today!

Join our panel and help us make 
the magazine even better!

10 

Take our 3-minute survey at 
3dartistonline.com/survey and 
win a place on our panel 

READER SURVEY

Hi. We absolutely love making 3D Artist 

and we hope you love reading it too. But 

this year we want to make it even better, 

so we’re asking for your help. By answering 

just a few questions, you could be selected 

to join our fi rst ever 3D Artist panel. 

Whatever your skill level or discipline, I’m 

so excited to hear what you have to say 

about our CG coverage and can’t 

wait to learn more about you.



  See new ideas and changes before anyone else

 Get invited to attend special events in your area

 Test third-party products for review

 Have a chance to meet the 3D Artist team 

 Shape the future issues of the magazine

 Enter into exclusive competitions

Complete our survey to join our 
3D Artist panel and:

Complete our survey and win your place today

3dartistonline.com/survey

Take the 
survey on 
any device

Only 
takes 3 
mins!

Complete
 survey

Step 1
Get 

involved

Step 2
Earn 

rewards

Step 3

Take the chance 
to get closer to 
the team than 

ever before
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 I used to make, at an almost professional 
level, plastic model kits. It’s something that 
gave me a bit of experience with Photoshop 
for making realistic textures for my 3D
models. The breakdown of the 3D is similar
to what I used to do with plastic models!  
Antonis Karidis, Migs NATO reporting name: Fulcrum, 2015

Have an image you feel passionate about? Get your artwork featured in these pages

Create your gallery today at www.3dartistonline.com

Antonis is a self-taught 3D artist 
and pilot instructor. He has 
worked for the likes of Ubisoft.

Antonis Karidis
artstation.com/artist/roen911

Software Cinema 4D, 
Photoshop, MARI

Work in progress…
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 My father read the 
story of the Green Man to 
me and always mentioned 
how disappointing the art 
was. He hated peaceful 
ones, as the Green Man

was unfriendly to humans.
So, here you go Dad  
Andy Jones, The Greenman, 2014

Work in progress…

Andy Jones
andyjonescreative.com

Software ZBrush, Cinema 4D, 
KeyShot

3DArtistOnline username: 
Andyjonescreative
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 The bacon campaign was developed by 
McCann (Stian Birkelid and Jan Petter Ågren) 

and fi nal retouches done by Fredrik Myhre.
The campaign sheds light on it being better
with bacon in water than water in bacon  

Øyvind Fiksdal, Bacon in Water, 2014

Øyvind is a digital artist who is 
working for agencies in Norway 
and starting his own business 

Øyvind Fiksdal
fxdal.com

Software ZBrush, MODO, 
Photoshop

Work in progress…
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 My idea was to create a minimalist 
house for a successful writer, who

had given up dealing with people and
passes all of his time writing  

Ângelo Fernandes, Writer’s home – office, 2015

Work in progress…

Ângelo Fernandes
angelofernandes.com

Software 3ds Max, V-Ray, 
Fusion, Photoshop

3DArtistOnline username: 
angelofernandes



Where ideas
take shape.

shutterstock.com

Streamlined search  •  Fresh content added daily  •  Simple pricing plans
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In depth

 The image is a creature concept 
developed in Bryan Wyniá s workshop
– that helped a lot when thinking about
different ways to approach a creation  
Lucas Ribeiro Fernandes, Mars Eagle, 2015

A CG generalist since 2004, 
Lucas aims to learn as many 
CG intricacies as he can 

Lucas Ribeiro 
Fernandes
lucasribeiro.tv

Software ZBrush, KeyShot, 
Photoshop

Work in progress…
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 I got started with 
references. At the 
beginning I decided to go 
with a flying creature and I 
started to pick some reptile
references to mix with
another kind of animal  
Lucas Ribeiro Fernandes, Mars Eagle, 2015

22

CONCEPTS 
I made some basic shapes in ZBrush that would help me 
design new ideas in Photoshop. I used Photoshop to paint over 
things, trying to figure out some new ideas and shapes.

RENDERING
To render I used the newly released ZBrush to 

KeyShot Bridge, and the result could not be 
better – it provided a high-level finishing render 
that was fast and intuitive. I rendered out some 

passes and composed everything in  
Photoshop for the final piece.

PAINTING
With the design set, I decided to 
move back to ZBrush and finalise 
the modelling. Afterwards, it was 
time to think about the colours. 
As I was following reptile 
references, I really wanted that 
reptile look for my textures.





THE BEST ADD-ONS TO ENHANCE YOUR CG WORK

PLUGINS
HACKS
 APPS
E

ver wish you could quickly and easily create 

500,000 objects in a scene but have it 

remain only 250KB in size? How about 

Avatar-worthy CG forests, a fully functional 

complex character rig or your own customised 

HDRIs for perfect lighting?

Well, it’s not just wishful thinking: someone’s 

developed a solution to all of them. 

Whether you’re an animator, TD, modeller or 

texture artist, exploring the world of software 

scripts, plugins and add-ons is the ultimate way to 

see an immediate improvement in your workflow. 

With them, you can cater whatever 3D software 

you use towards helping you get better at exactly 

what you do best – and use shortcuts for what you 

do worst. Some will even help you do things you 

wouldn’t even know existed. Best of all, most of 

them are free.

To help us pick, we’ve asked some of the best 

artists in the industry to join us in showcasing 100 

of our best plugins, apps and add-ons for 3ds Max, 

Blender, Maya, ZBrush and Cinema 4D. So what are 

you waiting for – turn the page to find that scripted 

solution to all your problems!

Astral Projection by Chris Chui24



Jahirul Amin
jahirulamin.com

3D trainer at Double Negative 

Hasan Bajramovic
hasanbajramovic.com

Freelance character artist

Daniel Banasik
etmed3d.blogspot.com

Freelance CG artist and motion editor

Ronen Bekerman
ronenbekerman.com

Founder of 3D arch-vis studio Polytown

Hugo Beyer
hugobeyer.artstation.com

Senior environment texture artist at 
Ready at Dawn

Gurmukh Bhasin
gurmukhbhasin.com

Concept artist at Cloud Imperium Games

Joey Camacho
rawandrendered.com

Motion and graphic designer

Chris Chui
artstation.com/artist/mxnarch

Freelance modeller and cloth FX artist

Stanislav Gorshenin
handfighter.deviantart.com

Freelance 3D artist with experience 
working on Disciples III and Postal III

Yasin Hasanian
superhero.cgsociety.org

CG artist

Mohsen Hashemi
psdesign-co.com

President of Phoenix Architectural 
Visualization group

Mark Masters
digitaltutors.com

3D generalist

Alireza Milani
escapist.cgsociety.org

Freelance 3D Artist

Pablo Muñoz
pablander.com

Freelance 3D Artist

Kate Pfeilschiefter
katepfeilschiefterart.com

Concept artist and illustrator

Andrew Price
blenderguru.com

Creator of training hub BlenderGuru 

Kenny Roy
kennyroy.com

Director of Arconyx Animation Studios 

Miles Sebesta
milessebesta.com

3D character animator

Daniel Sian
danielsian.com.br

Freelance 3D artist with clients like LG

Igor Sobolevsky
igoq.artstation.com/portfolio

Designer and concept artist

Ian Spriggs
ianspriggs.com

3D artist, known for incredibly realistic 
human portraits

Rob Watkins
wokosworld.com

Concept artist, worked on the Fable series

Jonathan Williamson
cgcookie.com/blender

Head Blender artist at CGCookie
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01 Forest Pack
itoosoft.com/forestpack.php€200 incVAT for

one-year subscriptionor free Lite version

Create vast surfaces of trees and plants and scatter

millions of proxies, high-poly meshes or billboards.

02 Soulburnscripts
bit.ly/1I3bOYQ Free

A collection of 79 amazing scripts to enhance Max

by Neil Blevins, some of which are based on those

written during his time at Blur Studio.

03 Catalyst
cgpack.com/catalyst$24 for two licences

A plugin to get five to ten times faster render times

through the optimisation of V-Ray render settings.

05 Image Composition Helper
cbuelter.de Free

Automatically visualise the Rule of Thirds inside the

3ds Max Viewport to instantly improve the look of

both your 3D static renders and animation.

06 Advanced Painter
bit.ly/1DXhgtpFree

A legendary script for randomly distributing a

selection of objects. Great for grasses, hair and fur,

and stones and pebbles. There’s even a toothpaste

generator option!

07 RailClone
itoosoft.com/railclone.php€200 incVAT for

one-year subscriptionor free Lite version

Generate complex parametric objects including

fences, stairs and floors faster than ever before.

08 Relink Bitmaps
colinsenner.com/scripts/relink-bitmaps Free

Easily relink missing files like bitmaps, VRayMeshes,

mental ray proxies and VRayHDRI when they

change directories or when you move computers.

09 Ornatrix
bit.ly/1d8ng9P$499

This professional hair and fur plugin for 3ds Max is

renowned for its quality and functionality, and it has

been used at studios like Unit Image and Blur.

10 MultiScatter
multiscatter.com$235

Create a scene with 500,000 objects at only

250KB right before rendering with this great tool.

11 Multimesher
kinematiclab.com Free

Intersect or subtract different meshes together

using multiple sources and Boolean operations,

perfect for adding instant interest to your model.

12 Unwrella
unwrella.com€149

Very few 3D artists like unwrapping UVs, but

Unwrella is here to help – a powerful plugin for both

Maya and Max that unwraps UVs in minutes.

13 Regularize Edge Loop
bit.ly/1QqQsby Free

Incredibly useful script for turning your poly

selection into a circle. Works with edge loops on

planar and curved surfaces as well as cross-

sections. It accepts multiple loops at once too.

14 DreamScape
bit.ly/1EmcFm0$645

Create sky, terrain and realistic sea surfaces

including reflections, refractions, bump mapping,

foam and underwater scenery.

15 MadCar
rendering.ru/ru_en/madcar.html€200

A great plugin for quickly rigging wheeled vehicles

and supports any number of wheels, from a

motorcycle to a lorry.

16 FloorGenerator
cg-source.com/floorgenerator.php Free

An incredible arch-vis script that generates floor

objects made of individual boards – works with

MultiTexture: cg-source.com/multitexture.php.

Plugin 01: Multipurpose 
Skyscraper by Mohsen Hashemi

Plugin 24: Maya from inside Oculus Rift with mOculus.io

Plugin 20: What Pulldownit 
can do for realistic fractures

17 FumeFX
afterworks.com/FumeFX/Overview.asp $845 

Also available for Maya, Sitni Sati’s plugin for 

smoke and fire simulation has been production 

proven in films such as Thor, Iron Man and Hugo.

18 thinkingParticles
cebas.com From €45 per month

This is one of cebas’ flagship plugins, known for 

procedural and physically accurate destruction 

and special effects simulations. It’s been used in 

blockbuster films like The Avengers, Captain 

America and Star Trek: Into Darkness.

19 RayFire
rayfirestudios.com $130 for an educational 

licence, $385 for full commercial licence

Fragment, destroy, blow up and do much more! 

Used to help create Diablo III cinematics and 

Transformers: Dark Of The Moon. 

20 Pulldownit
pulldownit.com From €395 

Also available for Maya, this dynamics solver 

creates realistic fractures as well as massive rigid 

body simulations. An ideal plugin for earthquakes!

04 Greeble 
max.klanky.com/plugins.htm Free
Created by Tom Hudson, one of the 
initial 3D Studio developers, this plugin 
generates random detail for everything 
from spaceships to cityscapes. 

26
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21 SpPaint3D 
creativecrash.com/maya/script/sppaint3d Free

Spreads and scatters your objects through painting.

22 Rapid Rig
creativecrash.com/maya/script/-rapid-rig-

advanced-auto-rig-for-maya $40

A powerful autorigging plugin for Maya, perfect for 

speeding up what is normally a very time-

consuming process.

23 The Setup Machine 
anzovin.com/tsm $99

This character rigging plugin produces a high-

quality skeleton and proxy, control rig, and basic but 

accurate skin weighting for models in a few clicks.

24 mOculus.io
moculus.io From $65.55

This Oculus Rift plugin for Maya enables you to 

create 3D work directly in VR, aiming to add more 

immersion into the creation process.

25 ZenTools 
creativecrash.com/maya/script/zentools Free

A great combination of tools for modelling, 

selection, UVLayout, hair and character setup. 

26 Golaem Crowd 
golaem.com From $1,980 for three months rental

Artist-driven crowd simulation to get an army of 

soldiers or a horde of zombies in no time. Used in 

Game Of Thrones, Hercules and more.

27 Miarmy
basefount.com/miarmy.html From £895 for three 

months rental

Great for crowd simulation, AI and behavioural 

animation, creature physical simulation and 

rendering. Lots of training and tech demos included.

28 Joint Splitter 
bit.ly/1Gpxy1O Free

This free rigging tool enables you to add additional

joints between two other joints with precision.

29 Elementacular
elementacular.alexandra.dk $175

Create volumetric clouds and control the cloud

shape by manipulating its underlying geometry.

30 My Merge Vertex
bit.ly/1DGy5p8 Free

Easily collapse and merge many vertices at the

same time by setting distance. Very useful for

whenever you create half a model and need to

mirror and connect together both halves.

31 froTools
froyok.fr Free

An excellent toolset developed specifically for

working faster with goodies for modelling, selection

and an enhanced UI.

32 Qtown
creativecrash.com/maya/script/qtown Free

Generate a procedural city. Even simple geometry

can look like more complex buildings, which now

come with automatically generated UV coordinates.

33 Zootools 

macaronikazoo.com Free

This set of open source scripts have been developed 

by programmer and animator Hamish McKenzie, 

and they aim to help both riggers and animators in 

their everyday lives.

34 FaceShift 
faceshift.com/maya Free

Stream live facial performances or import recorded 

performances directly into your character rig.

35 alShaders
bit.ly/1HvwEB9 Free

A fantastic production shading library for Arnold 

developed by Anders Langlands, who is now a Solid 

Angle employee. 

36 Comet Scripts 
comet-cartoons.com/melscript.php Free

A selection of free Maya MEL scripts to help riggers 

along the way.

38 Studio Library
studiolibrary.com Free

A completely free Python script for managing your

animation clips and poses.

39 UNFOLD3D
polygonal-design.fr From €299

Now included as standard inside Maya 2015 and

up, Unfold3D is a powerful program for creating fast

UVs with minimum effort.

40 ngSkinTools
ngskintools.com Free

Character skinning plugin for Maya that gives the

ability to smooth weights with no strange artifacts,

undo/redo problems, mirror weights without

needing to go to a T-pose and more.

Plugin 23: Anatomy Study The Dying Gaul by Ian Spriggs

41 tweenMachine
justinsbarrett.com/tweenmachine Free 

The easiest way to create breakdowns between key 

poses in Maya, excellent for any animator.

42 MgTools
mgland.com/MGtools_en.html From €60

A toolset made especially for character animators to 

get your best acting performance yet.

43 Blue Pencil
bit.ly/1DGy9oY $49 per licence, free demo

Bring advanced 2D drawing to your 3D workflow and 

Maya’s viewport with the help of this plugin. Blue 

Pencil includes many more features than Maya’s 

native Grease Pencil.

44 bhGhost Tool
graphite9.com/MayaDownloads.html Free 

The bhGhost animation tool provides a whole new 

approach to ghosting for animators, where only the 

outline of the character is shown in different frames 

so that the spacing of the full animation is much 

easier to see and distinguish. 

37 Autodesk Maya 
bonus tools 
area.autodesk.com/bonus_tools Free
Every Maya user should know about this 
free collection of Maya scripts and 
plugins from Autodesk.
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45 UV Master
pixologic.com/zbrush/features/UV-Master Free

UV creation has never been so easy with this

add-on that comes directly within ZBrush itself.

Make UVs with just one click!

46 RefBoard
bit.ly/1Ok4dKq Free

Designed to always stay on top of whatever

software you are currently using, this image viewer

lets you add, arrange and resize any images you like

to a saveable board.

47 Transpose Master
bit.ly/1zTP9aG Free

Available directly within ZBrush, Transpose Master

is designed to help you pose a model composed of

subtools, ready for rendering.

48 GoZ
pixologic.com/zbrush/features/GoZBrushFree

Easily transfer files between applications like Maya

and Cinema 4D, without setting up shading

networks. A huge workflow speed-up!

49 Mask Grow
bit.ly/1GeuGiR Free

This script will let you grow your mask in ZBrush,

similar to growing a selection in Photoshop.

50 ZAdjustor 2.0
bit.ly/1KnN4ty Free

Adjust Draw Size, Focal Shift, and Z/RGB Intensity

by simply moving the mouse or stylus on the x and

y axis while holding down a hot key.

51 PaintStop
pixologic.com/zbrush/features/PaintStop Free

PaintStop is a 2D drawing program that works

based on the use of real-life art tools such as pencil,

charcoal, pastel, marker and many more right in the

heart of ZBrush.

52 Multi Map Exporter
bit.ly/1ONHDVH Free

Included in ZBrush is Multi Map Exporter, designed

to automate map creation and export them for your

model with settings that can be saved and reloaded

for next time.

53 NanoTile textures
bit.ly/1Hzn3I3 Free

This unofficial plugin by Joseph Drust lets you make

seamless tiling textures using NanoMesh indexes.

55 Amaranth
pablovazquez.org/amaranth Free

Created by Blender Foundation certified trainer

Pablo Vazquez, these tools let you toggle to low-res

preview mode, refresh scenes and more.

56 Node Wrangler
bit.ly/1Hzpjz2 Free

A variety of tools for working more efficiently than

ever before through the use of node setups.

57 Start Cube Modelling
wahooney.net/category/addon Free

Speed up modelling with this add-on, which will

create a cube, slice half of it, add a mirror modifier,

enable clipping and take you into edit mode.

58 Asset Sketcher
bit.ly/1Ok5G3s$29.95

A Blender add-on that lets you paint objects directly

into your scene for plenty of intuitive detail.

59 Gaffer – Light Manager
bit.ly/1DqDDoA$17.95

Easily light your scenes with a simple interface,

presenting you with all the lamp settings you need

to tweak in a panel.

60 IvyGen
bit.ly/XWJNz5 Free

Quickly generate basic ivy to crawl across a wall or

natural environment – useful for detailing arch-vis.

61 GoB
bit.ly/1DjeFpW Free

Easily transfer textures and meshes between

Blender and ZBrush.

62 RetopoFlow
bit.ly/1JAVNYt $71.25

Retopology tools designed for artists! Enables you

to retopologise models directly in Blender.

63 Add Mesh Toolkit
bit.ly/1Ok616f Free

An epic script bundle that lets you add quick

meshes to your scene, including ladders, pipes,

gears and circular stairways.

64 Blender Camera Calibration
bit.ly/1DqEqG5Free

An open source add-on to calibrate your virtual 3D

camera so that its orientation and focal length

match the camera used for a given reference photo.

66 BookGen
bit.ly/1JAWMYB Free

Generate books in Blender to quickly and easily fill

shelves or cupboards.

67 Dynamic Spacebar Menu
bit.ly/1PtNbXB Free

Increases the functionality of the Spacebar for easy

access to commonly used tools and features.

68 Blender Muscle tools
cgcookiemarkets.com/blender/all-products/

blender-muscle-tools $19.95

Create muscles in Blender to make your rigs and

animations more realistic than ever before.

69 ANT Landscape
wiki.blender.org/index.php/Extensions:2.6/Py/

Scripts/Add_Mesh/ANT_Landscape Free

Generate procedural mountains and landscapes,

great for adding to the backdrop of any scene.

70 Sculpt Tools
blenderartists.org/forum/showthread.

php?316520-Sculpt-Tools Free

One of the best sculpting add-ons you can get,

modified by Blender Cookie’s Kent Trammel.

71 Archimesh
bit.ly/1EdqnGlFree

Quickly create accurate whole house structures

with all the correct measurements, including walls,

doors, columns, stairs and tiled roofs.

Plugin 60:Using IvyGen in
Blenderby Andrew Price

54 Decimation Master 
pixologic.com/zbrush/features/decimation Free
One of the fastest ways to reduce the poly count of your models without losing any 
details – very useful for reducing render times for still images. 

65 Sapling 
bit.ly/VfDnZS Free
Generate realistic parametric trees 
according to a method developed by 
Jason Weber and Joseph Penn in 1995.
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AxiomJetRacer ‘HeroShot’by
Igor Sobolevsky

72 V-Ray
What I enjoy most about V-Ray 

in particular is its simplicity for 

getting great lighting quickly. I 

also often use simple AO 

renders in V-Ray to check the 

model and details. Also the 

material resources are 

available to users online: it’s all 

free, and great for getting an 

idea of how everything looks 

before you go in and build it or 

paint it in Photoshop.   

Rob Watkins

V-Ray is defi nitely my favorite 

Max rendering engine. Without 

it, things would be harder. 

Hasan Bajramovic

73 Arnold
Hands down the most 

straightforward renderer I’ve 

worked with! Robust and easy 

to use for both artists and 

developers. Yasin Hasanian

74 RenderMan
The Academy Award-winning 

software tool, RenderMan, was 

fi rst developed by well-known 

animation studio Pixar. Now 

with the release of the 

RenderMan 19 plugin for Maya 

you can now render 

non-commercial art freely and 

without any limitation or 

watermarks aff ecting your 

work. RenderMan for Maya is a 

very powerful render engine 

indeed. Alireza Milani

75 OctaneRender
GPU rendering brings the 

power of thousands of parallel 

cores to work on calculating 

your fi nal images. These days, 

GPU rendering brings all the 

bells and whistles of a CPU 

render, such as motion blur, 

depth of fi eld, accurate 

refl ections and refractions, and 

global illumination. With the 

massive amount of time saved 

using a GPU render, you can 

use the extra production time 

to try to meet your clients’ 

expectations.  Kenny Roy
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76 Enhance: C4D
biomekk.com $99

This set of 178 procedural 2D and 3D shaders for

Cinema 4D provides the creation of an infinite

number of textures, patterns and surfaces.

77 Reeper
bit.ly/1GeAYPN Free

Create ropes or any other similar structures along

splines with this great plugin. Fantastic for any

abstract motion-graphics work.

78 Magic Snow
nitro4d.com/blog/freebie/magic-snow Free

Make snow effortlessly straight inside Cinema 4D.

79 Nitroblast
nitro4d.com/blog/donationware/nitroblast€40

A great fracturing plugin from the creator behind

Thrausi and Catastrophe. Provides completely

automatic collision driven fracturing.

80 Smart Poly Chart
bit.ly/1GeBs8gFree

Draws a neat bar chart containing every single

polyobject in your scene, beginning with those that

have the highest polycounts. Handy for organising

and optimising large scenes.

81 VUE
e-onsoftware.com/products/vue From$199 for

VueEsprit

Also available for Maya, 3ds Max and more, this is a

professional solution for realistic digital nature.

82 Arrow Toolkit
olivervogel.com/work/view/13 Free

Quickly and easily create arrows of any size along

any spline you want.

83 X-Particles
3.x-particles.com From£150

One of the most advanced particle simulation and

rendering environments around, enabling you to

generate up to 1 billion particles.

85 Xpresso Floor Generator
josefbsharah.net/xpresso-floor-generator Free

Create random, seamless, realistic floors.

86 Voxygen
cinemaplugins.com/c4d-plugins/voxygen £46.70

A procedural voxel generator to get that cool

old-school, pixelated cubes look. Transfers your UV

coordinates onto voxels for supereasy texturing.

P
ri

ce
s 

co
rr

ec
t 

at
 t

im
e 

o
f g

o
in

g 
to

 p
ri

n
t 

o
n 

th
ei

r 
re

sp
ec

ti
ve

 w
eb

si
te

s 
an

d
 s

u
b

je
ct

 t
o 

co
n

ve
rs

io
n 

ra
te

s.

MartinsCaféRobots
by Daniel Sian

87 Hangover
bit.ly/1I3taou $24.99 pro version 

This nifty plugin will notify you via email or text when 

your render is done, and it can even automatically 

shut down your computer after.

88 Microfloaties
joelotron.com/microfloaties Free

Add floating dust particles to your scene and control 

the amount, size and speed of them in your render as 

well as the scale of the area they occupy.

89 KRAKATOA
thinkboxsoftware.com/krakatoa Request an 

evaluation licence

KRAKATOA is also available for 3ds Max and Maya 

and is perfect for rendering millions of particles at 

unprecedented speed for the perfect dust, smoke, 

ocean surface foam and more.

90 HDR Light Studio
hdrlightstudio.com Commercial single licence £299 

Also available for 3ds Max, Maya, Houdini, MODO, 

and more, HDR Light Studio enables you to easily 

customise HDRI environment maps or simply create 

one from scratch for professional lighting.

84 City Kit 
store.greyscalegorilla.com/products/
city-kit $149
Build realistic cities that can be 
customised with a single click.
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Complete
  Unlimited webspace
  Unlimited websites
  Unlimited traffi c
  Unlimited e-mail accounts
  Unlimited e-mail storage
  Unlimited MySQL databases
  Unlimited domains (1 included)

Reliable
  Geo-redundancy
  Daily backups
  1&1 CDN
  1&1 SiteLock Basic
  24/7 phone and e-mail support

Simple
  1&1 Click & Build Applications 
including WordPress and 
Joomla!®

  1&1 Mobile Website Builder

UNLIMITED POSSIBILITIES FOR YOUR WEB PROJECTS*

1&1 UNLIMITED HOSTING

DOMAINS | MAIL | HOSTING | eSHOPS | SERVERS

NO LIMITS!

* 1&1 Unlimited from £2.99 per month. Some features listed are only available with 1&1 Unlimited Plus from £4.99 per month. 12 month contract term and 1 month billing cycle, paid in 
advance, then regular price applies. Prices exclude 20% VAT. Visit www.1and1.co.uk for full offer details, terms and conditions. Rubik’s Cube® used by permission of Rubik’s Brand Ltd.

0333 336 5509

CALL
SPEAK TO
AN EXPERT1TRIAL

TRY FOR 
30 DAYS1 MONTH

SHORT TERM
CONTRACTS1

1and1.co.uk

per month*
excl. 20% VATFrom

£2.99

NEW!
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W
orking at Pixar is a great opportunity 

to learn and hone skills as an 

animator, as Robb Denovan explains: 

“Whilst there are many great tools and tricks 

that are specifi c to Pixar and their software, I 

fi nd myself adhering to the same principles that 

have been around since the early days. One of 

the most revered books in animation is The 

Illusion Of Life and I am constantly referencing it 

as a guideline for my work. At Pixar, we are 

constantly trying to push the envelope with our 

animation but at the same time we pay homage 

to the original animators and the principles they 

developed.  

“We will talk about 12 key components for 

things that I try to include when animating. Some 

of the topics I will discuss are from The Illusion 

Of Life and other topics are things that I have 

discovered along the way that I fi nd valuable 

when animating.”

Pixar’s senior animator, Robb Denovan, looks 
at the studio’s animation techniques in depth 
and explains why they’re still relevant today

THE 12 RULES 
ANIMATIO

PIXAR
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All images © Disney Pixar

THE PIXAR WAY
Three of Robb’s key films include Brave, 

Monsters University and Inside Out

“Since arriving at Pixar, I have had the opportunity to work 

on many great fi lms at the studio including Brave, Monsters 

University and the upcoming fi lm, Inside Out. My fi rst project was 

the animated short fi lm ‘La Luna’, which tells the story of Bambino, a 

young boy coming of age in the most peculiar circumstances. I was 

given the task of animating the crucial shot of Bambino climbing a 

ladder and fl oating to the Moon. I also animated several key scenes in 

Monsters University involving Mike and Sulley, including the main 

confrontation between the two characters. One of the most 

enjoyable shots I animated was of Don Carlton, the ‘mature’ 

student and president of the Oozma Kappa. In the scene, Don 

dances across the dancefl oor at a sorority party. I shot a 

lot of footage of myself dancing really poorly and 

embarrassingly had to show the director my 

reference footage for approval!”
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01Squash and stretch “Considered

one of the cornerstones of animation,

squash and stretch is what breathes life into a

character. Without squash and stretch, all of our

characters would appear stiff and rigid. Even

seemingly rigid characters and objects should have

an element of squashing and stretching applied.

Squashing and stretching also demonstrates the

weight of a character. And it’s not just the body of a

character that can be stretched; I squash and

stretch everything on a character like the eyes,

hands and feet!

“Most animators have at one point or another

animated the ubiquitous bouncing ball, but it is

ubiquitous for a reason… every character in

animation is more or less a bouncing ball! Observe

the way a cheetah runs and you’ll see an abundance

of squashing and stretching. Though the cheetah’s

volume is actually staying the same, the cheetah’s

body is giving the illusion of squash and stretch.

One of my favorite things to do is to frame through

classic Disney films and see how the old masters

cleverly used squash and stretch to bring life to the

characters. Here at Pixar, we believe in the

philosophy that it is more important to feel the

squash and stretch than it is to see it.”

02Posing, silhouettes and lines
of action ”Posing is one of the key

factors in animating. A strong, clear pose gives the

audience clarity and offers us, as the viewer, an

insight into the character’s thoughts and

motivations on screen. Strong posing can also tell us

a lot about the physicality of a character; like if they

are heavy or light, tired or alert, strong or weak.

“Depending on the length of a shot, an animator

may have less than a second to convey the emotion

of a character to the audience. Instances like this are

perfect examples of why a strong pose is important.

There are many factors that influence a strong pose

but two of the most important for me are clear lines

of action and a lucid silhouette. There can be all

sorts of elements in the pose that lead our eye to

the intended focus point.”

03Timing ”Timing is a critical part of

animation and is the one aspect that often

gets overlooked by animators just starting out.

Although posing may come across as the main

component of animation, I would argue that timing

can provide the viewer just as much emotion,

attitude, personality and weight as a strong pose.

“For example, pretend you have two identical

bouncing balls in your scene. If your task was to

imply that one ball was extremely heavy and the

other extremely light, it would be difficult to

differentiate between the heavy ball and the light

ball. This is where your timing and spacing of your

animation sells the difference in the two balls. Not

only does timing tell the audience about the weight

of a character, it also helps sell the emotion of a 

character. Take a standard walk cycle. If the timing 

is very snappy and fast, this could imply that the 

character is nervous or energetic. Conversely, if 

your timing is very slow and evenly paced, one 

could assume that the character may be lethargic, 

sad or fatigued.” 

04 Research and reference ”I want 

to clarify that research and reference are 

two diff erent thing. Research is a critical component 

of animation that happens in the early stages of 

animation. You need to fully know your character 

and the environment before immersing yourself in 

the animation. My fi rst feature fi lm at Pixar was 

Cars 2, and for research the animation team went 

out to a racetrack and got to drive race cars with 

professionals. The drivers were instrumental in 

teaching us about the mechanics of what a car is 

doing when it drives around corners, skids, 

accelerates and so on. Whilst watching footage of 

race cars has its merit, researching and 

understanding how cars work was instrumental in 

creating realistic and believable car chase 

sequences in Cars 2. 

“Brave also required an extensive amount of 

research into a wide array of actions including 

archery and horseback riding. Until you actually 

attempt to release an arrow from a bow, you don’t 

realise how hard archery can be! But by 

understanding how to hold a bow and arrow 

properly and researching the correct technique, I 

was able to approach scenes with archery with full 

knowledge of how it should look when animated.

“Reference is an extremely integral part of 

animating a shot at Pixar. Having reference footage 

available enables me to analyse movement and 

motion in a detailed and precise way. Another great 

thing about reference footage is I can frame through 

a clip or play it at half speed, which enables me to 

observe subtle nuances in a performance. These 

nuances can often add much needed texture to a 

shot and bring it to life. There are several diff erent 

sources of reference that I use on a daily basis: 

online clips from sites like YouTube and BBC Motion 

Brave, one of Robb’s key films, won
many awards including an Academy
Award for animation
© Disney Pixar

The ball follows a defi nite path of action: study the spacing of the ball 

along this path. Notice the similarity of the ball action to the hop and jump 

below. This action also relates to the walk, run, leap, skip and so on

As the ball falls, its speed 
increases and the drawings 

are spaced further apart At the highest point, the 
action slows, drawings 

are spaced closer and the 
ball resumes its 
natural shape

Notice how the ball 
stretches when falling and taking 

off  at steps 5, 7, 12 and 14

As the ball hits, it 
recoils and becomes 

squashed

THE BASIC BOUNCING BALL ACTION
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Gallery are great places to find specific actions or

clips thatwill benefit yourwork. Movies and

television shows are also great sources of

inspiration. Certain actors have greatmannerisms

that lends themselves to animation. Filming yourself

is possibly themost beneficial form of reference

footage because you can tailor your performance to

the dialogue in your scene and you can always take

something away fromfilming yourself.When I film

myself acting out a scene, I try to get in character as

much as possible and physically embody the person

or thing I am acting out. Youmay feel silly acting it

out in front of a camera ormirror, but trust that only

good thingswill come fromanalysing that footage!”

05Developing an idea (acting)
”Acting is one of themost subjective parts

of animation and can easily be one of themost

frustrating! But as the story goes, animators really

are just introverted actors.When an animator is

given a shot, theworst thing that they can do is rush

straight into the computer and start animating. If

given the luxury, let the shot sit with you for a few

days and really spend time fleshing outwhat you

want to get across in the shot. Some ofmy best

ideas for a shot happen onmywalk home from

workwhen I am away from the computer and

distractions atwork.

“Think aboutwhat you are trying to say. Don’t

think about actions but think aboutmotivations.

And don’t ask how a character is doing something,

but askwhy a character is doing something. These

are two completely different things. One of the

most important things I’ve learnedwith acting is

understanding subtext and the truemotivations

behind a character. Break down the dialogue and

hunt for the true emotion in the shot. Humans are

complex creatures andwe are able to convey awide

range of complicated emotions all at once.”

06Blocking out a shot ”Oncewe

have committed to an idea thatwe have

for our shot through either thumbnailing or shooting

reference footage, it is now time to block out our

shot. One important thing I have learned since

joining Pixar is that there really is no right orwrong

way to block out a shot so long as your idea is

conveyed clearly to the director.

“The first thing I dowhen starting to block out a

shot is decidewhere the appeal is coming from and

what I want to get across to the director: will the

appeal come from strong posing or is the appeal of

the shot all in the timing and rhythm?

Understanding this will helpmewithmy plan of

attack. There are two basicmethods that I use to

block out a shot: ‘pose to pose’ and ‘layered’

animation – eachwith their own purpose and

benefit. One can argue that a great shot has both

which is undoubtedly true, butwhat I am concerned

about in the beginning is getting the director to buy

off onmy idea and the easiest way to establish clear

blocking. As a general rule, if the character isn’t

moving around thatmuch in a scene, I will focus on

strong poses and clear readability and if the

characters aremoving around a lot or there’s

choreography towork out in the shot I will block out

using a layeredmethod of blocking.”

07Polishing a shot ”Aftermy blocking

has been approved by the director, it is

time to polish a shot and bring it to completion. This

is the final stage of animation. At this point, my job

is to start smoothing out paths of action, smoothing

my curves in the graph editor and building on the

foundation that I laid in placewithmy blocking.

“When polishing, I’m now starting to refinemy

poses and timing so that it clear and precise. I’m

spending a lot of time on the intricacies of the

character with things like fingers, eyelids, eye

direction, costume and so on. This is when I spend

most ofmy time in the graph editormanipulating

my curves andmassagingmy slo ins and slo outs.

I’m also adding in little flourishes and accents inmy

performance that I didn’t include inmy blocking

passes. Aword of caution: don’t oversmooth your

animation. Inmany cases, there is appeal in the

messiness of your curves. Try smoothing it out but

if it ends up looking tooCG, revert back. I want to

make sure that I don’t lose the essence ofwhat is

workingwithmy blocking.”
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Robb’s latest work can 
be seen in Inside Out, 
released in June  
© Disney Pixar

FROM SKETCH TO CINEMA
The quintessential stages taken to create a scene in 
Monsters University 

The sequel to Monsters, Inc. stormed our screens in 2013, 

and with it introduced new techniques like ray tracing and 

global illumnation to Pixar. Take a look below at a CG pro’s 

typical working steps for a film like Monsters University.

STORY

MODELLING

ANIMATION

LIGHTING & 
FINAL FRAME

LAYOUT

ART

37



08Familiarising yourself with
studio tools ”Every studio has its

own particular set of tools that can prove to be a

valuable source of knowledge for animators and

Pixar is no different. It is very easy to develop your

own method for animating and become complacent

and comfortable in your workflow but I would

strongly encourage to try new tools that the studio

offers. Ask your other animators what tools they

use and what hotkeys they couldn’t live without and

try implementing these into your workflow. It’s

important to remember that these tools are

designed for the animator’s benefit to improve work

productivity and efficiency.

“On a similar note, if you have an idea for a tool

that would help improve an animator’s day-to-day

workflow, it is always worth talking to the tools or

the rigging department to see if your idea is worth

implementing. Some of our best tools at Pixar were

designed by animators wanting more from the

software and rigs.”

09Thumbnailing and note
taking ”Thumbnailing is something

that I have done since starting out in animation. I

find it to be second nature when it comes to

exploring ideas and thoughts about my shot. A

common misconception is that you need to create

perfect drawings. My thumbnails are messy and

very basic but they are important for me to figure

out what I want to animate. Another thing that I

find helpful is writing out a lot of notes about my

shot. I write notes for everything! I write about the

character’s motivation, I write about the physics of

what is happening and I write about the character’s

subtext. This is something that helps me work

through problems and questions that may arise

once I start animating.

“Once in the shot, I will always refer back to my

thumbnails and notes to make sure that I am not

deviating from my original plan. I have heard

countless animators say that they don’t need to

write down their ideas, but I personally find the act

of writing it down a good practice and a solid

reference point once animating.”

10Critical eyes ”One of the worst things

you can do as an animator is burrow

yourself away at your desk and not show your work

to peers and coworkers. With hard deadlines and a

tight schedule, it is easy to get into a pattern of

closing your office door, putting on your

headphones and animating. Even though your ideas

may be great, showing your work to others may

produce even greater results. Speaking from

long and I’m unable to see mistakes that I would

normally be able to pick up. By showing a co-worker,

I’m able to get a new perspective on my work. If you

were to give 100 animators the same scene, you

would wind up with 100 different takes. By reaching

out to others, you can only benefit from someone

else’s point of view regardless of whether or not you

agree with their notes. Find those peers whose work

you admire and pick their brain, get constructive

criticism and learn from them.”

11Generating an effective
workflow ”Generating an effective

workflow is something that is often overlooked

when discussing animation but can have a huge

impact on your overall work productivity. I like to

keep my workspace clear of any distractions. When

animating, I force myself to work in an order that

maximises efficiency. I start with the big ideas and

resist the temptation to add in unnecessary details

before getting blocking approval from the director.”

12Learn something new from
every shot ”After you have finished

your shot and the director has approved it, don’t just

start the next shot(s). I always try to learn

omething new from each experience. Maybe it’s

omething as simple as using FK arms instead of IK.

Or perhaps it’s a new method for animating eyes.

“On Monsters University, there were so many

haracters that I learned a new animation method

with each character. For example, some characters

had tentacles instead of legs which forced me to

earn how to animate tentacles. Other characters

had two heads! Whatever the situation is, try to find

omething new that you have learned to carry over

nto your next shots. An animator is like a musician

earning new songs; each new song learned only

helps the musician’s craft and get better as an artist.

“Each animator has different individual strengths

nd weaknesses. I personally try to address my

weaknesses head on by requesting shots that play

gainst my strengths in order to become a more

well-rounded animator.”

THE ANATOMY OF…
The animation techniques behind Mike 
Wazowski, one of Pixar’s most loved characters

“Though Mike Wazowski appears simple at fi rst 

glance, he was a difficult character to animate well. First 

off, he has one giant eye which also serves as his body so 

right away you are limited with acting choices. Acting out 

references for your shots required you to think about how 

your acting choices would translate to a character with no 

differentiation between a body and a head. Furthermore, you 

had to think about how one giant eye would aff ect your acting 

choices. Also, because of his simplistic shape it was very easy for him to 

appear rigid so making sure he remained malleable was paramount. This 

was done by treating his body like a bouncy rubber ball.”

To properly animate 
Merida’s archery pose, 

Robb undertook extensive 
research © Disney Pixar

PIXAR: THE 12 RULES OF ANIMATION
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I
n this tutorial we will explain the processes of modelling, 

texturing, posing and rendering a realistic Velociraptor. You 

will learn techniques for sculpting large muscle groups and 

skin folds, large, repeating scales and fine details such as 

small scales, skin pores, wrinkles and bumps. We will cover 

the texturing process, including how to use the Cavity map 

to make details pop and use the Edit Stencil tool in Mudbox 

to warp the stencils so that fine details will flow around the 

model convincingly. Posing the model is very important and 

can transform a plain sculpt into something lifelike and 

believable. Lastly, we will learn how to create materials and 

lighting in Maya for rendering convincing-looking skin.

Resurrect a realistic 
Velociraptor
Model, texture and render an aggressive, dynamic and 
realistic-looking Velociraptor in Maya and Mudbox



 RESURRECT A REALISTIC VELOCIRAPTOR

Alternativebasemodellingmethods
In Mudbox you need to start with a polygonal model as a

base mesh, but the base model can also be created in

different programs. You might like sculpting in ZBrush

with DynaMesh or building up your model with

ZSpheres, so choose the method which works best for

you. One advantage to working with a UV mesh is you

can quickly bake out textures and send the model back

to Maya. The model can be rigged and posed in Maya

and sent back to Mudbox as a sculpt layer.

04 Sculpt muscle and bone Work in layers as much

as possible – this gives more flexibility and lets you try

out ideas without worry. Subdivide the model to around 1

million polys, and work quickly and roughly with the Wax brush

to build up the underlying muscle, bone structure and overall

shape. Use the Move brush for larger adjustments to the shape

and proportions, and exaggerate the muscle definition and

bones under the skin. Look at the anatomy of dogs and big cats

to guide you in areas like the hips and ribcage.

05 Refine the model Smooth out the rough forms and 

refine the shapes of the muscles with the Smooth and 

Wax brush to give the impression of skin stretched over 

muscle. Try to avoid working on fi ne detail or scales at this 

point. Use the v_fold_vdm (Vector Displacement Map) brush 

to create large hanging folds of skin around the neck and limbs. 

Import and position the claws, eyes and teeth, and sculpt the 

eyelids, fingertips and gums around the imported meshes (lock 

the imported meshes so they are not aff ected as you sculpt).

0504

01 Collect references To create a believable creature, 

the fi rst step is to gather references from real life. We 

can never know what dinosaurs really looked like, but by 

observing creatures alive today we can make something 

convincing. Lizards, crocodiles and snakes are a good reference

for scales, skin colour and texture. But, note that dinosaurs

were not like modern reptiles (which tend to lie flat with limbs

splayed out to the sides), they are dynamic and have powerful

hind limbs. Look at bird claws for the feet and even dogs or

horses for the underlying muscle and bone structure.

02 Create the base model Set up a side view of your

dinosaur as an image plane to work from, ideally from

a real skeleton so you can get an idea of where the important

bones lie and how they might affect the shape. Model in a

symmetrical but relaxed pose with arms and legs slightly bent.

This model will be a base mesh for sculpting so it can be quite

simple, but do make sure it has the correct number of toes and

fingers, and the mouth is modelled in an open position. Leave

the teeth, claws and eyes as separate meshes.

03 Create UVs and clean up Make some UVs for 

your base model as it will let you quickly try out ideas 

for texturing and baking out test maps throughout the process. 

Make sure your model is symmetrical and the geometry is 

clean before importing to Mudbox and go to Edit>Set 

Topological axis. This will help if you accidentally start working 

with mirroring turned off – you can right-click on the layer and 

mirror the details across. Also, it will enable sculpting with 

mirroring on a posed, asymmetrical model.

JAYHOWSE
Raptor,2015

Software
Maya,Mudbox, Photoshop

Learnhowto

Concept
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02 03

DOWNLOADS
o filesilo.co.uk/3dartist

FREE
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06 Add large scales We will create a Vector 

Displacement Map to make a repeating ridged scale 

down the creature’s back. Create a plane in a new scene, 

subdivide and sculpt a detailed single scale. Try to create some 

overlapping parts to add more interest. Create another plane in 

the same place and use this as the target to bake a Vector 

Displacement Map. In your scene, import this map as a stamp 

and use the Repeat brush to create a line of scales down the 

back, making them progressively smaller as you reach the tail.

07 Sculpt leathery skin Find a hi-res view of an 

elephant or similar creature from a texture site such as 

cgtextures.com. Import it into Mudbox as a stencil and using 

the Edit Stencil tool, move and warp the image into place so it 

flows with the contours of your model. Use the Foamy brush on 

a very low strength to brush the texture onto your model. For 

the neck area the elephant’s trunk was used as a stencil, again 

warping the stencil around the curve of the neck. Use the v_

wrinkle_vdm brush to manually deepen some of the cracks.

08 Prepare scale textures Scales are the most 

time-consuming part of the sculpt, as much of the 

work has to be tweaked manually for a good result. For a 

general purpose, randomised hexagonal scale pattern, create a

4K texture in Photoshop and go to Filter>Texture>Stained glass

to make a basic texture. This simple texture can be quite

versatile as it will be stretched or warped later in Mudbox or

Photoshop to create different shapes, but you can build your

own scale patterns for different parts of the body if needed.

09 Sculpt scales using the stencils Edit the stencil

in Mudbox to create bulging areas and transitions

from large to small scales. This can also be done in Photoshop

with the Liquify tool. With the Foamy brush on a low strength,

add the scales to your model, making sure they follow the

contours of the body. Use the v_wrinkle stamp to manually

deepen some of the gaps and use Erase and Amplify to remove

or enhance the occasional scale to add a bit of variation.

06

07

09

Always think about your render
During the modelling stage it can be useful from time to time to bake out a quick Normal

map (even if the sculpt is unfinished) and bring the model into Maya to do some test

renders. If you start to set up your render scene early on in the sculpting process it can help

to identify any parts which aren’t working. Sometimes details will look good in the sculpt,

but it can get lost in the more subtle lighting of a render, or the render may show up areas

where there is not enough texture resolution or geometry.

10Add final details Add fine layers of noise and grime

to the model to break up the smooth surfaces. Add

occasional lumps and pores to the skin, cuts, missing scales,

abrasions and so on. Make sure you add asymmetrical details

across the central axis like scars, wrinkles and skin folds. Finally

check that the fine details are not overwhelming the mid-level

shapes of the model. If you’ve been working with layers you

should be able to tweak the layer opacity (you can even push it

up above 100 to increase the effect of a layer).

08

10
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 RESURRECT A REALISTIC VELOCIRAPTOR

Displacement and Normal maps
For this tutorial both a Displacement map and Normal map was used. Both maps were 

baked from subdivision level 3 of the model, which was used in the render. In theory you 

wouldn’t need a Normal map if your displacement has enough subdivisions, but in practice 

it just seems to help the details pop more. Experiment with this in your own project.

13

12 Create Gloss maps 

This map will probably 

be the one you spend the 

most time tweaking at render 

stage, as the ideal values can 

depend on the lighting in your 

scene. Start with the Diffuse 

map and go through each 

layer deciding how glossy it 

should be. For this tutorial we 

wanted the inner mouth very 

glossy and wet-looking, with 

drool and specks of blood 

around the nose and mouth, 

so these areas were all set to 

almost white.

11 Creating Diffuse maps Once the sculpt is finished bake out a Normal, Cavity and 

Ambient Occlusion map. Use Mudbox to block in key areas of the model on different layers 

– tongue, gums, mouth, claws, underbelly, eyes, dirt/dust and so on, and export the layers to 

Photoshop to add more detail. The Cavity map can be used to create dried dust and mud in the 

deepest cracks – invert the map and adjust the contrast and brightness until only the deep cracks 

are visible as white lines. Now make this layer additive and adjust the colour to yellow or brown.

13 Subsurface 
scattering map The 

mouth area should be really 

wet, gooey and nasty-looking, 

so it needs some subsurface 

scattering and in particular 

backscattering, but we don’t 

really want any scattering on 

the hard scales or leathery 

areas. Use the masks you 

painted for the mouth, gums 

and also the underbelly area. 

The mouth area should be set 

to white and the belly area 

maybe a midgrey to let a bit 

of scattering through.

11

12

Jay Howse
I have worked as a 3D artist in the games industry for 

around 14 years at Rare and Jagex. I am currently 

working with Indie studio MakinGames creating all the 

artwork for Raging Justice for Xbox One and PC.

Scarlett Maya, Mudbox, Photoshop (2014)  

A portrait of actress Scarlett Johansson to help me improve 

my face sculpting, skin and hair rendering skills.

Chimp Maya, Mudbox, Photoshop (2010)
A render of a young chimpanzee, I wanted to create the feel of

a piece of wildlife photography.

Snow Leopard Maya, Mudbox, Photoshop (2011)  

The rare snow leopard – sculpted in Mudbox and rendered in 

Maya/mental ray with Maya fur. Depth of field was achieved in 

post with a depth map and lens blur in Photoshop.

44



17 Final touch ups and compositiing Render out a depth map and use Lens Blur in 

Photoshop to add some depth of field to the image. The depth map can also be used to 

create some subtle distance fog. Add layers of smoke, rain and dirt in Photoshop to give the 

image a bit more life and utilise Color Balance and Curves to tweak the image to your liking for 

the final image.

14 Pose the model Export a mid-resolution version of the model from Mudbox into Maya 

(around 100K-200K) and set up a simple skeleton. It doesn’t have to be a fully working rig 

but if you add IK to the legs and arms, posing will be easier. Skin using a Heat map bind method 

for best results, and you shouldn’t need to do much manual skinning work unless you need really 

extreme deformations. If required, this model can then be sent back to Mudbox as a sculpt layer 

to add additional details, flesh folds and so on.

17

14 15

16

16 Extra tiny details Create strands of drool and water 

droplets around the mouth and apply a mia_material_x 

with the Water preset. Create lots of little spheres in the mouth 

and on the tongue to simulate bubbles of drool. Apply another 

mia_material, but this time use the glass_thin preset and 

change the IOR to 0.33. Bristles were modelled in Maya and 

added to the neck and back to add a bit more interest and 

break up the silhouette.

15 Lighting and scene setup We will use mia_material_x materials and HDRI lighting 

with a linear workflow for realistic results. The easiest way to set this up is to tick ‘enable 

colour management’ in Render Settings, then add an mia_exposure_simple node to your camera 

with gamma 2.2. The important thing to remember is to then set any normal maps to Linear 

sRGB. Choose a suitable HDR map and add extra directional or area lights if required.

Add subsurface to mia_material_x
To add subsurface scattering to an mia material, create a 

misss_fast_skin_maya material and set the ambient, 

diffuse colour and overall spec to 0, then middle-button 

drag the shader into the Additional Color slot of the 

mia_material. Finally, in the Shading Group of the 

mia_material add the lightmap node created by the sss 

material (under Lightmap Shader, drag in the lightmap 

node from the Hypershade – it should be called 

something like misss_fast_lmap_maya). Now the 

scattering effects from the skin shader should be added 

to the mia shader.

All tutorial files can be downloaded from: filesilo.co.uk/3dartist 45



DOWNLOADS
fromfilesilo.co.uk/3dartist

FREE
YOUR

I
n this tutorial we’ll be taking an overarching look at some

3D character workflows. We will go through the process of

constructing characters, from basic modelling and

sculpting to building textures and materials, posing and

rendering. We’ll be creating a steampunk scene with

two characters that are very different from a technical

standpoint. Each character will present us with a distinct set

of challenges, which enables us to explore a variety of

tools, techniques and workflows. While building our

machinist, we’ll get to practice an organic character

workflow. We’ll go over techniques for modelling and

sculpting anatomy, clothing and accessories, as well as tools

for quickly unwrapping clothes and baking perfect detail

maps. Our guardian character will have us work through

balancing the character’s motion functionality and aesthetic

appeal. We will also explore techniques for quickly texturing

metals and building convincing materials. Finally we’ll build a

quick environment and set up our scene for rendering.

01Guardian block-in
Let’s start with a quick,

rough pass. This block-in gives us

an early look at our character’s

overall shapes and it’s important

since our character’s proportion,

overall feel and personality will

get lost between the concept art

and the 3D model. By blocking in

the full character as quickly as

possible, with minimal regard for

edge flow, neatness and so on,

we avoid wasting time on work

that will most likely need to be

redone. We can worry about

edging and cleaning once our

block-in feels like our concept.

Texturedistinct
steampunkcharacters

02 Build our parts library Now we can start looking at

our overall forms and figuring out our individual parts

based on the character’s intended functions. The best part

about working on mechanical characters is that, just like in

real-life machines, a lot of parts can be reused. We only need to

model out a few types of protective plates and one of each part

so that the arm can rotate, twist, bend and so on. This means

that we are saving a lot of time in modelling and UV layout

while creating a cohesive and believable design.

ALDO VICENTE
Machinist and the
Steam Powered
Guardian, 2015

Software

Learn how to

Concept
01

02

 TEXTURE DISTINCT STEAMPUNK CHARACTERS

 Lock down the look With our small library of parts 

and our block-in as a reference, we can start fi nalising 

our model. We can duplicate, shift and modify existing parts to 

fill in the rest of our character. We have to keep function in 

mind to a certain extent (knees have to bend like knees, for 

example), but there’s no need to overthink all of the internal 

workings of our machine. Form and silhouette should take 

some priority. Hard surface parts can create very rigid-looking 

forms, so it’s important to emphasise the S-curves in our 

design to give our character a lively and natural feel.

03
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 Hard surface parts can create 
very rigid-looking forms, so it’s 

important to emphasise the S-curves 
in our design  



04 Clean our mesh Neat, well-distributed edges are 

helpful for UV layout and surfacing. The Sculpt 

Geometry tool on Relax mode, or the Relax Vertex tool are very 

useful here. Let’s delete the back faces on our guardian’s outer 

plates. This will reduce poly count, save UV space and make 

unwrapping much easier. Double extrude border edges has 

tons of benefi ts; we get a consistent edge loop around our 

mesh, we create support edges for smoothing and UV-relaxing 

algorithms, and we’re adding subdivision density around our 

borders to provide more fringe detail when sculpting.

05 Build the anatomy In this step we want to create 

our machinist’s anatomy with concept-accurate 

proportions and clean edge fl ow. Generally we want to keep 

this mesh relatively low poly, as we will be using it to extrude 

our clothing and accessories later on. We can start with an 

available generic anatomy model, or we can build a simple base 

mesh in Maya and take it into ZBrush. Here we’ll manipulate 

the physique to fi t our character. Our machinist is a cross 

between a blacksmith and an engineer, so we need his 

silhouette to convey that he frequently works with heavy 

metals and equipment.

06 Model clothing 
and accessories 

Let’s bring our machinist 

mesh back into Maya, and 

make sure our character is at 

real-world scale. Split up our 

model into the basic areas of 

our head, shirt, gloves, pants 

and boots. We can repeat the 

process to create geometry 

for the vest, belt and harness. 

Instantly we have fi tting base 

geometry for our character’s 

costume. We only need to 

refi ne our clothes meshes to 

a certain point, as most of the

clothing detail will be done in 

ZBrush. We can use basic 

box modelling to shape the 

belt straps and harness.

07 Prepare our costume for sculpting First, we should be sure again that we have

neat, even edge distribution. The majority of this should have already been in place from

our machinist anatomy model, but we can use the Quad Draw tool in the Modeling Toolkit to

quickly and easily make improvements to edge flow wherever necessary. Again we should

double extrude our border edges, for the reasons listed in Step 4. We could do UV layouts at this

point, but it may be preferable to do it after sculpting as some of the geo may change

considerably, and our UVs may need to be redone.

 TEXTURE DISTINCT STEAMPUNK CHARACTERS

05

06

07

04

Sculpting warm-up exercise
Sculpting clothes wrinkles can take a lot of practice and iteration. It’s about getting in the 

right mind-set rather than any particular brush or technique. I recommend starting with an 

exercise to help get a feel for cloth folding. Create a simple sphere on a ground plane, with 

a plane right above it. Imagine the above plane is a tablecloth, and try sculpting how it 

would land if you were to drop it onto the sphere on the ground. Try this same exercise 

with more complex shapes, and imagining diff erent types of fabrics. This helps us warm up 

and get a really solid grasp of how clothing and folds work.

08 Sculpt the clothes Here we’ll be sculpting in the large and mid-level detail of our

clothing. This includes the overall structure, drape of our clothes and the wrinkles. We

won’t be sculpting in the fine detail such as the threading and stitching of the fabric, as we’ll be

adding those details via our textures later. It’s good to have reference of the types of fabric each

piece is made of. Keep in mind that these are just panels of fabric falling over simple anatomical

shapes. Also consider that these folds need to stay generic enough to work in most poses.

08
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Image-based lighting
Metal materials are mostly reflective, so in order to get

realistic-looking metals, we need to provide them with an

environment to reflect. For this, we’ll use image-based

lighting. In the Render Settings, go to the Indirect Lighting

tab, and click ‘Create Image based Lighting’ to put an IBL

sphere in the scene. We can load an HDR image into our

IBL sphere node – free HDR images are available online.

Now all we need to do is turn on Final Gather. At render,

mental ray will use data from our HDR image to light the

scene and create some convincing environment

reflections for us.

09

09 Lay out the UVs To unwrap our clothes, we’ll use 

RoadKill, a free plugin for Maya. We can select our 

vest mesh, and run the plugin. In RoadKill we double-click to 

select the shoulder seam edges and hit C to cut the UVs. 

Instantly, we will see our vest fl attened neatly in our UV viewer.

We can quickly repeat this to separate the lapels and we’re 

done. If we want to smooth our UVs out further, headus is 

another free option with an excellent UV-relaxing algorithm 

and a very simple, but fantastic GUI for fl agging, bunching and 

stretching in your UVs.

12 Create the metal textures Now we should export 

our Polypaint data as a texture map and bring it into 

Photoshop as an overlay layer with our base metal colour 

underneath. The grey in our grunge map will disappear, leaving 

us some dark grunge and light scratches that will go over our 

base colour. We’ll also add a subtle metal photo texture over 

our base colour and colourise our grunge to get a rusty red hue.

This is our Diff use map. We’ll fashion a Bump map with 

desaturation and then invert our scratches to black. We’ll raise 

our base colour to near white and then adjust the noise layer to 

a medium grey. 

11 Paint metal grunge It’s hard to distinguish which UV 

islands correspond to what plates by simply looking at the

fl attened mesh. This makes it diffi  cult to paint our textures in 

2D. Instead, let’s turn on ZBrush Polypaint and subdivide our 

mesh into the millions. We can start this off  by coating our 

mesh in 50 per cent grey. Let’s set our brush to RGB Color 

Spray with a grungy alpha and zero z-intensity. We’ll paint in 

the edge grunge, rusting and scratches. At this point we are 

only concerned with colouring this detail onto our mesh. 

Grunge and rust should be darker values while scratches 

should be a white colour.

10Unwrap the guardian Our guardian has a lot of internal and external parts, but we

can save a lot of time and UV space by using 3D procedural textures on the smaller, less

visible internal parts. We’ll only unwrap the outer metal plating of our guardian. Let’s select our

plated parts, export them to ZBrush and run the UV Master plugin. Because of the cleanup and

double extrudes back in Step 4, our plates are essentially curved planes with structured border

edges. This makes them ideal for the UV Master algorithm. Almost instantly, we get a clean,

evenly scaled UV layout for all our plates.

11

12

10
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13 Create metal materials Metal materials are refl ection-based so we’ll use image-based 

lighting to give our metals something to refl ect. Using mia_material_x_passes, we’ll plug 

in our Diff use and Bump maps. Metals have low diff use weights. Our metal is relatively rough – it 

has a smooth, metallic microsurface, but its overall surface is too rough to cleanly refl ect any 

image. We will get a certain level of gloss but our specular refl ectivity should stay low. To control 

this further, we can fashion a Specular map from our Bump map by adjusting the levels to fi t 

within our desired refl ection values.

14 Bake good maps We’ll bake our maps using 

XNormal. With our vest as an example, we’ll export the 

high and lower-res meshes. To create a cage mesh in Maya, 

we’ll duplicate the lower-res mesh, and with Translate set to 

Normal we’ll move all the verts out along N. The cage mesh 

should be just big enough to fully envelope both high and 

low-res meshes. Now we’ll take our meshes into XNormal. 

Right-click on the low-res mesh and click ‘Browse external cage 

fi le’ to assign our cage mesh. Set to Average Normals and Bake! 

This will produce full, clean, accurate and fast maps!

 TEXTURE DISTINCT STEAMPUNK CHARACTERS

13 14

15 16

16 Texture the equipment For our equipment, 

textures, we’ll use a technique similar to Step 11. With 

the help of ZBrush Polypaint, we’ll colour in the rusting and 

scratching around our equipment’s nooks and edges. We can 

bring these maps into Photoshop and colourise or do a photo 

texture to create a grunge eff ect. Again we’ll repurpose the 

same maps to create our bumps, indenting scratches, dinks, 

rust and noise. We can add neat decorative pieces by adding 

black-and-white patterns into a Bump map, and overlay these 

patterns into our Diff use map to make them pop even more.

15 Texture the machinist Normal and AO maps are a 

great starting point for Diff use, Bump and Specular 

textures. In Photoshop, paint base colours for each island in our 

UV map. Multiply the AO map over the base and Overlay the 

green channel of our Normal map to create top-down shading. 

Now we’ll tile and overlay images of fi ne fabric detail. We can 

use those same overlays later on top of a grey background to 

create our fabric bump texture. Let’s paint in some subtle layers 

of dirt, dust and grunge to fi nish our diff use texture.

Understanding map baking in XNormal
XNormal casts rays from the lower-res mesh surface to the hi-res surface. The rays’ travel 

distance and normal data is written as colour data to the UVs of the lower-res mesh to 

create our maps. However, there is a travel distance threshold – if the rays travel past that 

distance without reaching the hi-res surface, they get ignored and no data is written to the 

map. This is why we use cages around our meshes instead of distance thresholds. The 

cage surface becomes the new distance threshold, ensuring we collect all the hi-res data, 

with optimised calculation time.
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 With the help of ZBrush 
Polypaint, we’ll colour in the 
rusting and scratching
around our equipment’s
nooks and edges  
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19 Make a background environment Let’s create a 

simple ground or wall backdrop. We’ll give the wall 

extra edges to indicate where the brick meets the concrete 

segment. We can use planar mapping to quickly get UVs. In 

Photoshop, we’ll use photo textures of bricks and concrete to 

create a quick Diffuse map. We’ll balance the levels and colours

to make the different images fit each other. Now we can 

fashion a Bump map by desaturating and pushing recesses into

black, while pulling convex surface space up to white. To add 

depth to our environment in Maya, we can apply a bend 

deformer and create a rounded wall.

20 Render our scene Let’s set up render passes for 

better control over our final image. In Render 

Settings>Passes, we’ll create and associate beauty, AO, diffuse,

Indirect, reflection, refraction, shadow and specular passes to 

all three. We can render and save these passes out individually 

for compositing in Photoshop. We should use ‘Linear Dodge 

(Add)’ blending mode to put our passes together and re-create

our beauty pass. Finally, let’s create a custom matte pass, 

assigning different coloured surface shaders to each character 

and the environment. Now we have full control for tweaking 

each asset and element to make our final image.

18 Build the remaining materials We’ll need to build 

several different material types for our equipment. With

our maps ready, gather reference and create some fresh MIA 

materials. First, name all our materials, turn on Use Fresnel, and 

input the real-world Fresnel values for each one. Now we can 

start balancing the Specularity and Diffuse, knowing that our 

reflective distribution is accurate. Since there’s no refraction, 

we can observe our reference and estimate the reflective 

strength, and the shade strength from zero to one. With MIA’s 

energy conservation math in mind, we can solve for really 

accurate reflective and diffuse weight values.

17 Clothes shaders Let’s import our machinist textures 

and plug them into a new mia_material_x_pass. 

Remember that the Normal map gives us the fold and wrinkle 

detail, while our fabric bump maps gives us the fine stitching 

and cloth detail. Both will be plugged into the shader. The cloth 

for our vest, pants and shirt is generally pretty diffuse, with very 

low gloss and specular reflectivity. We should also adjust the 

BRDF as looking at cloth at direct angles is especially dull. We 

can add a tiny bit of translucency, or we can fake it by plugging 

in a very weak mia_self_illumination node.

 TEXTURE DISTINCT STEAMPUNK CHARACTERS
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All tutorial files can be downloaded from: filesilo.co.uk/3dartist

MIA energy conservation math
The MIA materials are physically accurate, meaning that 

Diffuse plus Reflection plus Refraction will never be more 

than one – the total incoming light. But how do our input 

values get balance out? When we increase the value of 

one of these, its resulting effect takes energy from the 

result of the others to maintain the same total energy 

output. It breaks down as follows: 

Diffuse result = (Diffuse weight value) – (1/2 Reflectivity 

attribute value) – (1/1 Transparency value);

Reflectivity result = (Reflectivity attribute value) – (1/2 

Diffuse effect) – (1/2 Transparency attribute); and

Refraction result = (Transparency attribute value) – (1/2 

Reflectivity attribute value).
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When working on the light rig,
always use the same neutral light
setup. This makes matching
materials a lot easier  

S
etting up complex background environments for a 

project on a tight schedule always is a challenging task, 

especially when working in a small team. Also, chances 

are that changes and iterations will have to be made until the 

very last moment of production. So in cases like these, being 

able to build materials for lots of diff erent building assets in a 

short amount of time, while keeping everything as 

nondestructive and versatile as possible, is imperative. 

In issue 80, Georg-Sebastian Dressler showed us how to 

create a building using a modular approach. In this follow-up 

tutorial we’ll pretty much use the same philosophy with 

surfacing our asset. This means we’ll not simply paint our 

textures from scratch for each asset individually, but rather 

go ahead and build ourselves a tileable texture library fi rst, as 

well as a library of predefi ned materials and objects that we’ll 

then use on our building, such as wood, brick, lamp posts 

and so on. The idea is to get approval for the basic look and 

feel (using shader ball line-ups for example) before we throw 

everything we need onto the model. Doing it this way saves 

us from having to go back and forth between painting 

textures, applying them and most importantly: doing it for 

each of our buildings in the scene!

So once we’re fi nished with setting up the libraries (a 

process we have not talked about in detail since this tutorial 

is more about using the stuff  you already have prepared 

rather than creating it), we’ll go ahead and check our asset 

for errors such as overlapping UVs or missing geometry. 

Once we’re done we’ll use triplanar projections for basic 

displacement as well as Diff use Color materials which we’ll 

then blend together using UDIM masking in MARI, always 

keeping an eye on the right scale of our tileable textures. 

We’ll also try to keep the balance between time and quality, 

making sure not to use too much detail in areas where it’s 

not needed. We’ll make some fi nal adjustments to our 

materials before assigning our library mats to minor parts of 

the model, such as chimneys, doors and windows. 

01 Prepare your libraries We won’t go into much 

detail on how to create libraries as they depend heavily 

on the pipeline you’re working in. However, here are some 

general tips for setting up libraries for this project. First make 

sure every texture is tileable. Resolution is also crucial for a 

quick projection workfl ow, so we strongly recommend you set 

up your textures in 4K or higher. Scale is important too and 

scaling down is always better than having to do a blow up. 

Keep every tileable texture category (like brick, plaster a.s.o.) 

the same scale. This makes it a lot easier for working on other 

assets on the same scene, because you already know the right 

scale values. Also do a line-up of your materials to check if the 

colour, saturation and refl ection values are matching the overall 

look. Finally, when working on the light rig, always use the same 

neutral light setup. This makes matching materials a lot easier.

Modular background 
buildings in Maya

02 Check your assets Time to begin. Open a fresh 

scene in Maya and import both the asset and the light 

rig (alternatively you can use the scene provided). Select the 

geometry and open the UV Editor. Zoom in and check if there 

are any overlapping UVs. If you fi nd any, move them to a free 

space on top of the UDIM list. Also make sure there is no 

hidden geo left in the scene. We’ll export the object to MARI in 

just a moment, and we don’t want to mess up our UV layout 

with geo that we don’t need.

In the fi nal part of our tutorial, learn how to use projection and 
UV-based techniques to create asset materials

(Part 2)
CHRISTIAN RESKI
Venice, 2015

Software
Maya, MARI, V-Ray

Learn how to

advantages of asset and 
V-Ray material libraries

basic displacement and 
texture layout 

MARI for masking materials

projections and UV based 
layer masks 

and where to put detail onto 
your model’s materials

Concept
The main goal for this project 
is to create a fast and effi  cient 
surfacing workfl ow for an 
architectural asset, always 
taking into account artistic 
freedom as well as reusability 
and simplicity.

01

02

 MODULAR BACKGROUND BUILDINGS IN MAYA
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04 Combine and export Select the GRP_GEO in the 

outliner and duplicate it. Hide the original. Remove the 

GRP_MSR_RIG as well as the constraints from GRP_GEO. 

Select all the duplicated geometry in the viewport and do a 

Mesh>Combine. Select the combined geo and delete its 

history. Now export the combined mesh as an OBJ. Once 

you’re done, delete the combined mesh as well as any leftovers 

from the duplicate, and unhide the original. Now let’s take care 

of our building’s displacement.

05 Basement displacement property Select the 

basement geometry by going to Create>V-Ray>V-Ray 

Displacement>Apply Single V-Ray Displacement. Select the 

node, and in the Attribute Editor go to Attributes>V-Ray and 

choose Subdivision and Displacement Control and ‘Subdivision 

and Displacement Quality’. Since we’ll be using 8-bit maps we’ll 

need to play around with the displacement settings. Turn on 

Subdivide UV, set Displacement Amount to 4 and 

Displacement Shift to -2. Switch on Keep Continuity, set Edge 

Length to 3 and Max subdivs to 24. 

 MODULAR BACKGROUND BUILDINGS IN MAYA

05

04

03 Basic scene setup
Once everything has

been imported into the scene,

open the render globals and

choose V-Ray as your

renderer. Start with a

resolution of 1K square or less

for your physical cam. Later,

we’ll up the resolution for

better detail evaluation.

Under V-Ray>Global options

check the Displacement box.

Use 1/12 for your image

sampler, Threshold is 0.03.

Use linear colour mapping

with a Gamma of 2.2. Note

that the light rig does

overwrite both reflection and

GI. Turn on GI with brute

force for primary bounce, and

turn secondary to none.

Assign a standard V-Ray

material to the building.

03
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06 Triplanar displacement shader network  
Open Hypershade and look for the file node. 

Right-click it and choose ‘Create as projection’. Change Proj 

Type to TriPlanar. Turn off Filter Type and assign it to 

basement_layer01_brick_disp_1k.png. Change the scale value 

of the 3D placement node to 100 in XYZ. Create a 

MultiplyDivide node and then connect the projection.out Color 

to input 1 (in case you want to change the layer’s intensity 

later). Create a LayeredTexture node and connect 

MultiplyDivide.outColor to input[1]. Now plug the 

LayeredTexture.outColor into the value slot of a luminance 

node and middle-drag the luminance node onto the 

Displacement mat of the V-Ray Displacement property.

07 Create a projection tree for the pavement 

Now, do a test render. Adjust the scale value and 

displacement values if necessary. Once you’re happy with the 

result create another projection tree and put it on top of the 

brick layer in the LayeredTexture node. Assign basement_

layer02_grey_disp_64.png to the file node. This is just a 

neutral grey template for the pavement. You can use any other 

texture if you like. Now go ahead and create a standard file 

node. Plug it into the top layer’s Alpha slot. This file node is 

going to contain the mask that we’re going to paint in MARI in 

just a moment.

06

07

Makea reasonable compromise
When time is of the essence, knowing what will be visible in the final shot is key to saving

time and efficiency. Once you know the look of the project and where the camera is going

to be, you will have to decide how much detail is going to be needed, where to put it, and

how render time can be saved by scaling down shader complexity. For this project,

reflection is only used for certain materials, same goes for normals and bump. Also,

knowing the assets are background elements with a moving camera makes it easier to go

without too much stone shader detail.

08 Floor and wall displacement Select all three

GRP_walls and create another V-Ray Displacement

property. From here on out it’s basically the same workflow as

the basement (you can duplicate the basement’s network if you

want to). Now plug floors_layer01_brick_disp_1k in the first

layer of the displacement network and floors_layer02_plaster_

disp_2k.png in the second layer. You can use a scale of 110 in

XYZ for the brick and a scale of 400 in XYZ for the plaster.

Also, set the value of the plaster’s translate X to -100 and

translate Y to 200. This will shift the plaster a little so that it

doesn’t end up looking too repetitive.

08

09

09 Create a MARI displacement mask Open 

MARI and start creating by clicking on File>New 

Project. Under Path select the combined geo that we had 

exported earlier. Now create a new RGB, 8-bit channel in 2K, 

and click OK. Select all of the UDIMs and go to 

Patches>Fill>Black. Create a new layer. Hide the basement geo 

and start painting some wear and tear into the corners using a 

white brush colour and low intensity. You can use edge 

masking to avoid any projection tearing. 
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13 Tweaks and more MARI masking Rebuild the 

same shading network for the basement. Use 

bricks_018_capuccino_var_01_color_2k.png for the base layer 

and plaster_030_beige_var1_color_1k.png for the second layer. 

Same thing with the blend mask. Now, to generate a little more 

visual interest you can do something like this: put a HSV node 

between the projection and the LayeredTexture, and play 

around with the values. Put the layer on top of the plaster and 

paint a mask in MARI. Plug the mask into the layer’s Alpha slot 

to create more colour variation. Redo this as often as needed.

14 Paint a waterline Create a new channel in MARI. 

Select the basement’s UDIMs and fill them with black. 

Create a new layer. Grab some reference pictures and decals of 

moss and grime, and load them into MARI. Start painting a 

waterline using the Paint Through brush. Use the ortho view in 

conjunction with lock panning to the x axis and Repeat mode to 

make quick progress. Use separate layers for each texture to be 

more flexible. Once you’re done, hide the black fill layer and 

export the layer flattened as a PNG sequence. Keep the Alpha 

and only export the selected patches.

12 Get colourful The workflow for the main materials is 

pretty similar to displacement. Create a triplanar 

network with two layers, but drop the luminance node as we 

don’t need it. For the floors, connect bricks_002_color_2k.png 

to the bottom layer’s file node and set 3D Placement scale to 

150 in XYZ. For the plaster layer use plaster_015_yellow_var1_

color_1k.png and do the same for the scale. Use the same blend 

mask from when we blended the displacement.

11 Finalise our building’s displacement Back in Maya, 

select the floor displacement’s empty file node we 

created earlier, browse to the path you exported the UDIM 

sequence to, and assign the displacement mask sequence by 

choosing the first image. Once it’s assigned replace the frame 

number 1001 with the template string <UDIM>. This will tell 

V-Ray to automatically look for a UDIM sequence. Under Color 

Balance turn on Alpha Is Luminance as well as Invert under the 

Effects tab. Do the same for the basement displacement 

property mask. Now tweak the painted mask in MARI.

 MODULAR BACKGROUND BUILDINGS IN MAYA
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10 Export the MARI mask sequence Once you’re done painting the mask, right-click 

on the channel and choose Export Flattened>Export Current Channel Flattened. Choose 

a template name and file type like PNG. Enable Small Textures and remove Alpha Channels. 

Make sure the $UDIM string is contained in the name of the patch sequence, then click Export 

All Patches. Now duplicate the channel, delete the brush layer, create a new one and then repeat 

the same process for masking the basement section of the model, using white colour for the 

pavement areas. Make sure to name everything accordingly.

10
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AlternativeMARI export
Instead ofmanually entering the <UDIM> string inMaya for each file node, you can use a

script inMARI that automatically generates a shading network for you (you’ll find it under

Python>Export>Export forMaya). This network contains all UDIMs combined in a

LayeredTexturewhich is connected to a standard Blinn shader. The LayeredTexturewill

have a lot of inputs so itmight bemore convenient for you tomake an asset out of it. This

method can help in situations like distributed rendering, where youwould otherwise run

into path resolving issues.

Preview render of our shaded building

Our asset at each stage, from start to finish

A wireframe of our asset
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17 Assign V-Ray library materials Select your 

window doors and assign the wood material. Use the 

gold material for window decoration, door knobs and hinges. 

For chimneys use a mixture of brick and metal materials. For 

the roof tiles you can use an orange plaster texture as a basis, 

extract spec and normals from it using a tool like Knald, and 

tweak the colour with either Photoshop or a HSV node.

18 Final tweaks and
render setup To

finalise our asset, start by

naming all of your shaders!

Select all of your 3D

placement nodes in the

outliner and move them to

the MSR_Rig inside GRP_

GEO>GRP_MAIN. This way,

all the projections will get

exported with the model.

Once everything is set, go to

your Render Globals. For a

decent quality render, choose

a resolution of 1000 by 1500

pixels and increase GI brute

force subdivs to 300. Turn on

Light cache as secondary

bounces with a subdiv value

of 1000. Use Light cache for

glossy rays. You can also

increase the reflective

material’s reflection subdivs

to at least 64. Done!

16 Create the stone Paint a stone texture in MARI for 

the building’s corner stones, balconies and windows. 

Export the channel, plug it in a LayeredTexture and put a V-Ray 

dirt layer on top which you set to multiply. In MARI, duplicate 

the stone channel and use levels and saturation filters to turn it 

into a bump. Export it and use it in your stone material. Give the 

material a slight reflection with a glossiness of around 0.8.

15 Add the waterline layer Create a file node in Hypershade and browse to your 

waterline image sequence. Again, replace the frame number with the <UDIM> string. 

Plug the file node’s outColor in the HSV’s colour port and put it on top of the basement material’s 

LayeredTexture. Use the file node’s outAlpha as the layer’s Alpha channel. Use the HSV node to 

colour correct the layer until it matches the overall look of the building.
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All tutorial files can be downloaded from: filesilo.co.uk/3dartist

Keep an eye on displacement
Always be careful with multiple displaced objects in your scene, especially when their 

values are set pretty high. The more displacement you stuff in there, the heavier the 

workload for your machine or farm is going to get. So instead of buying lots of RAM, try to 

work efficiently and only turn on displacement for objects that really need the detail. 

Whenever an object is far enough away from the camera or is occluded by characters or 

other objects, do yourself a favour and switch displacement off.
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T
his tutorial walks you through the steps of blocking in 

an écorché study of the face in ZBrush. Écorché is the 

age-old practice of sculpting or drawing the body 

without skin in order to study the forms of the underlying 

anatomy. Here we build up the main anatomical forms of the 

face and discuss their importance to portraiture. 

Sculpting or drawing a face is one of the most challenging 

things an artist can attempt. Most artists wander in the dark 

when creating a portrait – placing planes and locating 

features based only on observation and experience. With 

lots of practice this can lead to good results, but everyone 

can benefi t from a road map that helps them work faster and 

better. Knowledge of facial anatomy is just that – a guide to 

the forms and regions of the face. The face, like the body, is a 

puzzle of interconnected anatomical pieces. Once the artist 

learns common shapes and connections he can quickly block 

in a likeness. The goal of this tutorial is to familiarise you with 

these common anatomical structures.

01 Fit the skull We fi rst need to get the skull to fi t the 

volume of the reference portrait supplied. Turn on 

transparency and adjust the proportions with a large Move 

brush. The areas of the skull that should be superfi cial (ie near 

the surface) are the eye orbits, the zygomatic arch (cheek 

bone), bridge of the nose and forehead. The rest of the skull has 

muscle, fat or cartilage between it and the surface. It is 

important to appreciate where the skull is closest to the surface 

so we can use these as landmarks when constructing a portrait.

Master facial 
anatomy

02 Place the masseter The masseter is the fi rst of two 

skeletal muscles that we need to place. Skeletal 

muscles connect bone to bone and articulate a joint (as 

opposed to facial muscles which articulate the skin to create 

expression). In this case we are connecting the mandible (jaw) 

to the zygomatic arch. The masseter creates signifi cant surface 

form on the face and needs to be located correctly. In ZBrush, 

block in the shape with your preferred geometry creation 

method, then subdivide and detail.

03 Understand the temporalis The temporalis is our 

second muscle of mastication (chewing). This muscle 

combined with the masseter, give humans a wider range of 

motion for biting and chewing. The temporalis is a large, 

distributed fan-shaped muscle that anchors to the skull along a 

crescent (the temporal line) that stretches from the upper-

lateral corner of the orbit back to behind the ear. This 

distributed muscle body converges, focusing its power, and 

passes behind the zygomatic arch, grabbing onto the anterior 

point of the mandible called the coronoid process.

Model an écorché study and pick up the fundamental 
anatomical structures critical to portrait sculpting

SCOTT EATON
Facial Anatomy 
Ecorche, 2015

Software
ZBrush

Learn how to

landmarks of the face

of the skeletal muscle 

subcutaneous and deep fat 
deposits of the face

surrounding orbit 

on the form and expression 
of the face

Concept
This piece is intended as a 
reference guide that looks at 
the critical anatomical forms of 
the face, including skeletal 
muscles, eye and nose 
construction, muscles of 
expression and fat deposits.

02

03

01

 MASTER FACIAL ANATOMY

Geometry creation
In this tutorial we need to create a number of subtools for 

the various anatomical forms of the face. ZBrush gives us 

a smorgasbord of tools for creating geometry, so how 

you proceed is up to your own workfl ow and preferences. 

For this exercise I used a combination of ZSpheres with 

adaptive skin, the new QCube (under the Tool>Initialize 

menu), and InsertMultiMesh Curve brushes. My 

workfl ow involves appending a very low-res mesh that I 

can pull and shape with the Move brush, then I subdivide 

and detail using ClayTubes and alpha 54 or similar.

DOWNLOADS
from fi lesilo.co.uk/3dartist

FREE
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 The masseter creates significant 
surface form on the face and needs to 
be located correctly  



04 Construct the nose cartilage The nose exhibits 

an amazing amount of variation in life. It is important 

to understand that despite this variety, all noses are built from 

the same three pieces of cartilage and a small bit of fat. The 

septal cartilage establishes the midline of the nose. The 

complex shape of the alar cartilage creates the ball of the nose, 

and the lateral cartilage creates the side walls of the nose. 

Finally to funnel in the air we have a wedge of fat that creates 

the nostril of the nose. Using your best construction skills, 

construct this geometry over the nasal opening of the skull.

05 Place the eyeball An adult human eyeball is approximately 24mm in diameter, there 

is small variation in this but it is a very useful average. The most common mistake in 

people’s portraits (in CG anyways), is that they always make the eyeball too large, wedging a 

grapefruit into the orbit and then trying to get the eyelids to fit properly. Here, with a correctly 

sized sphere (do it visually as our skull is not to scale) centre the eye in the orbit, and move it 

forward to the point where the bone of the orbit still protects it.

06 Make eyelids using tarsal plates The eyelids 

have two stiff plates of cartilage in them called tarsal 

plates. These form the foundation of the lids and are anchored 

to the orbits by something called the canthal ligaments. The 

medial (inner) canthal ligament is visible on the surface and so 

creates important surface form, the lateral one attached inside 

the rim of the orbit and is not visible. Paint a mask on the 

eyeball and then use Subtool>Extract to make your tarsal 

plates. Use your favourite geometry creation method to place 

the ligaments, then DynaMesh the result together.

07 Construct orbital fat With the eye and lids in place you can see the large cavity we 

need to fill with orbital fat. Orbital fat is packed all the way into the orbit and is what 

cushions and holds our eyeball in place. With age we can see this fat pushing out of the orbit, 

giving us characteristic bags under our eyes. Construct half a donut of fat and locate it in the 

space between the tarsal plates and the rim of the orbit.

 MASTER FACIAL ANATOMY

05

06

07

04

Getting facial fat right 
Not many artists appreciate how significant the fat deposits of the face are to the character 

of a portrait. In fact, almost every écorché study omits them. Fat is responsible both for the 

beauty and softness of youth as well as the craggy hollows of old age. In dissection, fat 

looks quite a bit like kernels of corn. To achieve a fatty texture in ZBrush use the Standard 

brush with Stroke set to DragRect and a suitably fatty alpha. I used alpha 62 with judicious 

use of the Smooth brush to texture the fat on this piece. 
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08 Put in the 
oribicularis oris 

Our lip/mouth muscle is the 

first of two orbicular (circular) 

muscles on our face, made of 

concentric rings of muscle 

fibres, which pull inward in 

various combinations to 

make a variety of lip shapes 

and phonemes. The muscle is 

extremely complex as many 

surrounding muscles will  

pass fibres into it. Here we 

show the deep cheek muscle, 

the buccinator, merging into 

the orbicularis oris from the 

sides. The buccinator 

originates above and below 

the molars and passes fibres 

into the deep section of the 

orbicular muscle.

08

Scott Eaton
Scott Eaton is an artist, character supervisor and 

anatomy instructor living in London, UK. He is a 

classically trained sculptor who has been teaching 

anatomy to digital artists for over a decade. Scott also 

contributes his expertise to film and commercial VFX 

and he has worked as lead modeller and character 

supervisor on numerous films. He has taught anatomy 

to studios around the world including Industrial Light & 

Magic, Valve, Framestore, Ubisoft and many others.

Torso Studies ZBrush, Mental Ray (2014)
Study of the articulation of the shoulders and back from Scott’s

digital figure sculpture online course.

Hephaestus ZBrush, Mental Ray (2009)
Digital sculpture of the Greek god Hephaestus. Hephaestus

was the crippled blacksmith of Mount Olympus, shown here in

repose at his forge.

Mermaid Study ZBrush, Mental Ray (2011)  

Unused mermaid concept sculpt from Pirates Of The Caribbean.

10Cut orbicularis oculii The face’s second orbicular muscle covers the orbit and eyelids

and is responsible for blinking, squinting and raising the cheek. It extends quite far over

the orbital rim and wraps medially to attach to the medial canthal ligament. Here we have cut

away the medial half of the muscle to keep the orbital fat and tarsal plate exposed. Use ZSpheres

or an IMM Curve brush to get geometry wrapping around the orbit, then flatten it and

DynaMesh it. Use the TrimRectangle tool to cut off the medial half.

09 Make deep 
cheek fat pads 

There are a couple of fat pads 

in the deep recesses of the 

skull that act as cushions for 

the facial muscles. These 

deep cheek fat pads sit over 

the buccinator and squish out 

into the depression in front of 

the zygomatic bone and a bit 

above the zygomatic arch. 

The volume of these fat pads 

determine the size of the 

hollow in a person’s cheek. 

The man in this portrait has 

very hollow cheeks so keep 

the volume small as you 

construct these fat pads.

09

10
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11 Build forehead muscles – temporalis and 
corrugator These two muscles are important 

contributors to the expressions of surprise, anger and sadness. 

They are thin muscles so they don’t create surface form but we 

certainly recognise the expressions they create. For the 

temporalis, create a flat sheet of geometry from just above the 

orbit to the top of the forehead. Medially it stretches almost to 

the centre, laterally to the temporal line. The corrugator is a 

small diagonal muscle that spans the space between the base 

of the nose to a point approximately mid-eyebrow. Place this 

using a small piece of geometry.

12 Lift the lip The human face has a network of muscles 

that articulate the upper lip. The muscles anchor into the 

upper edge of the orbicularis oris muscle (as well as 

intermingling fibres into the lip). They are called (from left to 

right): levator labii superioris alaque nasi, levator labii superioris 

and zygomatic minor. They are respectively responsible for 

wrinkling our nose, sneering and subtly deepening the 

nasolabial furrow (the furrow that comes off the nose and 

proceeds down by the corner of the mouth). Construct these 

like little pieces of linguini. Note: there is also a sneaky 

corner-lifting muscle not shown here.

13 Construct the zygomatic major The muscle, 

zygomatic major, is our smile muscle. It can be difficult 

drawing or sculpting a smile but once you understand the 

origin/insertion and action of this muscle, the construction of 

the smile becomes easy. Build this muscle from the corner of 

the mouth out to the lateral surface of the zygomatic arch. It 

has the widest pull of any of our facial muscles and lifts and 

stretches the lips when it activates, creating a big smile.

 MASTER FACIAL ANATOMY

11

12

13

Facial muscles
Facial muscles often create very little surface form so you 

might think they aren’t interesting to us as artists, but we 

absolutely need to know them because of the 

expressions they make. Once we know the construction 

of the muscles, ie the origins and insertions, we can 

derive the expression it creates. Each muscle also has 

characteristic wrinkle patterns that we are programmed 

to read, even when very subtle. There is a lot to learn 

about expressions but the best way to start is by 

studying the underlying musculature. 
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 For the temporalis, create a flat 
sheet of geometry from just above the 

orbit to the top of the forehead. 
Medially it stretches almost to the

centre, laterally to the temporal line   
67



16 Construct the malar and midcheek fat Now that

the muscles of expression are in place we need to cover

them with subcutaneous fat. We have a critical fat pad, called

the malar fat pad, that is located below the bottom of the orbit

and lateral to the base of the nose. It helps create the nasolabial

furrow. As we age it sags and separates from the other

subcutaneous fat deposits. Here we also construct the

triangular mid-cheek fat pad, also quite defined on our model.

17 Build the submental fat and jowls The last few characteristic fat deposits are

located on the lower face and under the chin. The submental fat compartment, our

double chin fat, is constructed underneath the chin. Be careful not to extend it out too far to the

sides, nor too low. Adjacent to this are a pair of jowl fat compartments, one above and one below

the jawline. Construct these like small parcels of fat that gravity has had its way with over time.

15 Depress the lip and lift the chin The opposite of the upper lip lifters (Step 12) is the 

lower lip depressor, depressor labii inferioris. It anchors onto the jaw just inside the 

depressor anguli (Step 14) and then ascends, grabbing onto most of the body of the lower lip. 

This flat sheet of muscle retracts your lower lip showing your bottom teeth. Adjacent to this 

muscle is the last muscle of the tutorial: the mentalis. This funny little muscle anchors between 

the lower teeth and chin, and grabs onto the fat pad that covers the chin, raising it when 

activated. It is shown cut away here.

14 Pull down corners Just as we had zygomatic major 

pulling the corner of the mouth upwards to create a 

smile, we have a corner depressor called depressor angulii oris, 

that pulls the corner down to create a frown. This muscle pulls 

on the corner of the mouth but also passes fibres into the 

upper part of orbicularis oris. Some of this form can be visible 

on people’s faces. A second small, but related, risorius muscle 

pulls the mouth wide and slightly downward. Unusually, it 

originates from the skin over the masseter.

 MASTER FACIAL ANATOMY

14 15

17

16

All tutorial files can be downloaded from: filesilo.co.uk/3dartist

Final thoughts and continuing study
We have come quite far in a 17-step tutorial. I tried to fill it with useful anatomical 

information but space is short. I hope this tutorial has excited your interest in facial 

anatomy and that you can appreciate how knowledge of facial structure can improve your 

portraiture. There is so much more information to cover on all fronts but we will leave that 

for another time. If you would like to learn more, I refer you to my website (scott-eaton.

com) where I have a number of additional resources to help you continue your study.
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P
roduct design has several steps and processes that

should be adhered to when making a successful product,

and by following the next steps you can increase the

percentage rate of success – from concept to completion.

By evaluating and identifying the problems within the

market, we will be able to develop new ideas and solutions that

can solve these drawbacks. These ideas can arise by focusing

on the lack of solutions in the market or else by improving a

product already made that does not work as it should.

Next, when it comes to researching we need to ascertain if

there are any similar products that have been previously

manufactured, in order to prevent the making of replicas. Here

you should work on identifying problems within current

products and try to improve them. After the researching stage,

you can start coming up with concepts and ideas that can

bring new solutions. This is where sketches are drawn of a

product that will be functional in the market.

Then we need to look at the feasibility phase: this step must

be highlighted. A team of engineers and technologists must

prove to the management team that all is working correctly, 

before creating a commercial product, by using prototypes that 

work via ‘proof by existence’. In the prototype stage, the 

designers must turn their sketches into 3D designs to 

represent the product in all angles and set forms, and it is 

noteworthy that they don’t need to be functional at this stage.

In the prototype revisions step we need to check the correct 

dimensions, construction, features, appearance, functions and 

so on. Experts and customers should do exhaustive testing. It 

is important to take a look at the product details and create an 

attached revision documentation.

If all of the previous stages have been successfully 

completed and approved, it’s time to continue with the 

manufacturing process for the product.

Make sure you take a look at the video for this tutorial on 

FileSilo and the detailed steps below, where we teach you how 

to design 3D products in SOLIDWORKS.

01 Create the base shape Firstly, activate the current 

view as ‘right’ (via the small cube in the viewport). Then, 

go to the Sketch tab and there you can fi nd a list of small icons, 

some of these are named ‘spline’. Click on this icon and try to 

re-create the shape like the image in the screenshot below. Keep 

in mind that you need to drag and drop the spline points but try 

to draw a point, then drag and click. Using this process, you can 

create something like what we’ve created below. If you created a 

lot of useless points, click on the points and delete them.

Model industrial designs

GustavoÅhlén is the
founder of Svelthe. He
is also a 3D/VFX
designer for films,
games and advertising

Gustavo Åhlén
facebook.com/gustavoahlenstudio
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02 Use the Offset Entities tool This 

tool enables us to add sketch entities 

by offsetting faces, edges, curves or sketch 

entities to a specified distance. This is perfect 

for creating an outline from our first spline done 

in the previous step. This will create a new 

rounded contour for extruding in the next step. 

To create this, you need to edit the current 

sketch, and click on the icon Offset Entities in 

the Sketch tab. In the Parameters tab you 

should set a low value because if you use high 

values some points may overlap. Check the 

option of Bi-directional and Cap ends.

03 
Extrude the surface Now we need

to delete the first spline done in Step 1 

(middle spline) and keep the rounded outline. 

Then, we will need to extrude the surface. 

Enter the sketch now and go to 

Menu>Insert>Boss/base and select Extrude. 

Select Mid Plane in Direction 1 and then 

underneath it, put in a value – something along 

the lines of 110mm – in D1. These values are 

references for this tutorial, but you can increase 

the measurements according to your own 

personal tastes or product. Now you will have 

to confirm the process. 

04 Create a new contour This new 

spline will be used as an extruded cut. 

Now you need to change the plane and in this 

case we have changed it from right to front. 

Then, using the same process as we have for 

the previous steps, you need to create a similar 

spline as the current image for reference. You 

need to create the middle of the entire shape 

and a vertical central line in the middle of the 

chair. Then, select the spline that you’ve 

created and click Mirror Entities. In the ‘Entities 

to Mirror’ slot, select the spline and in mirror 

about you will need to select the centre line. 

05 
Cut the shape If in the previous step 

some points are unwelded, you need 

to edit the sketch, select both points and 

right-click. There you will see a menu with a 

small icon of two lines joined in a point. Click on 

this icon and now cut the shape over the other 

axis. These cuts are perpendicular. Select the 

sketch, go to Menu>Insert>Cut> and select 

Extrude. In Cut-Extrude go to the Direction 1 

slot and select Through All and check ‘Flip side 

to cut’. To get a preview of what you’ve done so 

far, click on the glasses icon.

02 03 04

05

Axonometric and isometric
Axonometric projections could look a bit distorted but 

these projections work great for interior rooms or 

buildings. Axonometric projections go in three different 

axes directions: vertical and 45 degrees left and right. 

Isometric projections go in vertical and 30 degrees left 

and right. It’s important to clarify that these projections 

don’t exist in reality – they are views without perspective. 

Unlike in reality, the segments in the distance keep the 

same scale as everything in the foreground, giving an 

isometric view. In reality these segments are larger or 

smaller as they extend closer to or away from the viewer.

71



06Get the shape Once you have used 

the option of Cut-Extrude we will 

reveal the final shape. This shape can be 

modified – by going to ‘FeatureManager 

Design Tree’ and then Cut-Extrude, you will 

find that the sketch can be modified by moving 

the points of the spline. Keep in mind that 

some of these points have relations and these 

relations don’t let us move about freely. So to 

solve this problem you will need to click on the 

green icons around the points and delete them. 

You can also change the relations of those 

points with other points.

07Chamfer the edges This option will 

enable us to improve our model. Firstly 

you don’t need to select all the edges around 

the chair, you only need to select the back 

edges. Select the sky-blue edges (you can take 

a look at the screenshot to the far right as a 

reference). Now go to Insert>Features> 

Chamfer and use these parameters: 5 for 

Distance and 45 degrees for the angle. You will 

get a preview of the final shape with a yellow 

line as you can see here. Modify the values 

according to your personal preference and after 

this, click on the green tick.

08Appearance, scene and decals 
In the top of the viewport you can see 

some icons – click on the icon that has been 

marked with a red circle in our screenshot 

below. There you can change the studio 

lighting. We’ve used ‘3 point green’ and a wood 

material. To change the material, right-click on

the object and you will see an icon named 

Appearances. A new menu will be open and 

you will see a small icon with a texture on 

there. Left-click it and a new menu will be 

opened with all the materials appearing on the 

right-hand side.

09 
Render and technical planes The 

final step is the rendering, so click on 

the SOLIDWORKS Add-ins tab and there you 

will be able to see an icon named Photoview 

360. This option will activate the render 

options by the right panel. To create planes, 

you need to click on the 3D views tab at the 

bottom. Change the viewport orientation, and 

capture the view. Do this for the three views. 

Then, open a new document as a drawing one 

and import the views to go over the plane.

Get in touch for answers
to your technical quandaries 3dartist@imagine-publishing.co.uk @3DArtist            www.3dartistonline.comfacebook.com/3DArtistMagazine

All tutorial files can be downloaded from: filesilo.co.uk/3dartist

06

07

08 09

Interesting featured tools
In my particular case I recommend you 

take a look at some great tools that I’ve 

found in SOLIDWORKS, which are 

Extruded Cuts, Mirror Entities, Swept 

Cuts and Project Curves. Project Curves 

is one of the greatest tools because you 

can create a spline over a plane, and if 

there is any object behind the plane of 

that spline, you can project this spline 

over the object. If the object is curved, 

the spline will be adapted to the object 

creating cleaned cuts. This is perfect 

when combined with Swept Cuts. 

 TECHNIQUES
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Maya 2016

A
new version release is always exciting, but 

before you dive in, you’ll need to reacquaint 

yourself (again) with interface changes. 

Visually there’s not much to worry about. There 

are updated shelves, a new colour scheme and 

tweaked icons. If you need it, the interface will 

scale in resolution, which maybe handy if you’re 

giving demos or in a classroom environment for 

example. Layout changes to Menu Sets and 

Menus naturally take a while longer to adjust to, 

but if you’re hopelessly lost, there’s a useful Find 

Menu Item tool or you can roll back changes to a 

previous version. 

Impressive revamps to the Hypershade make its 

older version look very tired. It feels like a 

Hypershade 2.0, and far more adept for look 

development. Quite simply, it looks fantastic. The 

new Material Viewer works in real-time for 

shaders, bump maps and 2D textures. After 

selecting your renderer, there’s a choice of objects 

to see the Material applied. You can then preview 

the result in HDR environments too. Underneath, 

is a Property Editor – these can be toggled 

between a Look-dev version of most common 

attributes or the traditional Attribute Editor layout. 

The Node Editor has replaced the old work area 

and supports multiple tabs for working on multiple 

shaders. Several other windows such as the 

Outliner and Texture Editor can be docked here too 

which largely spells the end of having to ferret 

around trying to find where you left windows. It’s 

now also possible to one-click certain solo nodes 

via the Node Editor and preview what it is doing in 

the scene, which is ideal for troubleshooting.

Sculpting tools (derived from Mudbox) have 

been added which performed brilliantly for quick 

low-poly sketching, terrain generation and 

relatively high-poly modelling. When we reached 

around 6 million polys it may come as no surprise 

that Maya was less than happy with the process 

– so for higher-end sculpts you will still need to 

look elsewhere. But it does increase the amount of 

work you can do in Maya with fewer trips to 

Mudbox for simple tasks. Mudbox’s texturing tools 

have been left out, but in the Visor you’ll find 

stamps and some base meshes. 

In the Deform Menu, the Delta Mush Deformer 

has been added to the roster. It’s designed to help 

with skinning by smoothing deformation issues 

from bad skin weights. It’s very easy to use with 

good results achievable in just a couple of minutes, 

and we suspect over the coming months that it will 

accompany the trusty weight hammer as one of 

our go-to skinning tools. 

Rigged character animation also gets a boost via 

Parallel Rig Evaluation which is multithreaded. It 

enables Maya to utilise both CPU and GPU, 

speeding up playback in the Viewport enough to 

require less frequent Playblasting.

Relative newcomers XGen and Bifrost receive 

improvements in 2016 – XGen is now 

multithreaded and has a library (based on Maya 

Fur) which lets you start with presets to alter, it’s 

very useful for hair and provides an alternative to 

nHair as guides can now be sculpted. Bifrost now 

includes an Adaptive Aero Solver for atmospherics 

(smoke and mist). Two effects we trialled were a 

large plume of smoke with fire from an old style 

cannon and a modern rocket launch smoke trail, 

but we struggled to create them and found the 

setup and testing rather time-consuming. The new 

Foam system produces good results, but has a 

plethora of settings to manage.

This well-rounded update removes many of the 

frustrations that have bottlenecked users in the 

past, and the highlight for Maya 2016 has to be the 

redesigned Hypershade, although we would 

personally like to see particle brushes added 

sooner rather than later.  

Paul Champion

New features, performance 
improvements and a welcome 
digital makeover revealed

Industry experts put the latest workstations,  
software & 3D printers through their paces
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LEFT Performance boosts, new tools and existing upgrades mean
you can spend less time working and more time playing golf!

BELOW Useful Sculpting Base Meshes for animals, bipeds, 
clothing, props, vehicles and weapons can all be located in the Visor

ABOVE Troublesome skinning problems that arise when 
animating have the potential to be fixed in mere minutes using
the Delta Mush Deformer

TOP LEFT The ability to view certain nodes in Solo mode using 
the Hypershade is achieved by simply clicking the S icon

TOP RIGHT The addition of sculpting tools in 2016 makes light 
work of modelling tasks such as terrain generation

 Sculpting tools (derived 
from Mudbox) have been 

added, and performed 
brilliantly for quick  

low-poly sketching, terrain
generation and relatively
high-poly modelling  

Verdict

Summary

Maya 2016 has a brand new look and the workflow 

improvements make this a valuable upgrade

Price   £186 inc VAT / $185 per month,  

 £1,488 inc VAT / $1,470  per year

Stand-alone licence price   £3,100/$3,675

Website  autodesk.com/products/maya

OS  Windows 7 (SP1), 8.1 Professional,  

Mac OS X 10.9.5 and 10.10.x,

Red Hat Enterprise Linux 6.5 WS,

CentOS 6.5 Linux 

CPU  64-bit Intel or AMD multicore processor 

graphics hardware (parallel CPU and GPU usage to 

accelerate playback and manipulation of character rigs) 

RAM  4GB (8GB recommended)

Disk space  Minimum 4GB

Essential info

Features

Performance

Design

Value for money

MAYA 2016  

6 REASONS 
TO UPGRADE:
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3ds Max 
2016

O
ver the years there have been upgrades in 

3ds Max and usually these changes are 

small but nice tools. However, we now 

have a bunch of essential, new and updated tools 

for our 3ds Max arsenal, especially as 3ds Max 

2016 now combines 3ds Max and 3ds Max Design 

together for one mega product release. 

When you open up 3ds Max 2016, the interface 

looks almost the same apart from the Scene 

Explorer docked on the left that first came with the 

2015 version. Scene Explorer is a rejuventated 

Layer Explorer, which, other than the Hierarchy 

view, also has the Layer View that can now have 

nested layers within layers. It’s intuitive and you 

will get used to it in no time, plus you now have 

different workspace templates. Importantly 

though, in the latest release Autodesk has made 

some giant leaps for the industry – just the MCG 

(Max Creation Graph) alone is a game changer. It 

will no doubt help out the whole community in 

building procedural scripts and tools for 3ds Max. 

The MCG is a node-based scripting tool, and 

you can wire parameter nodes and connect 

procedural tools and modifiers in minutes. They 

can then be saved as a MAX tool XML file and a 

MAXCOMPOUND – both can be easily shared 

with the community. What does this mean to the 

average user who doesn’t know anything 

about scripting and building tools though? Even if 

you don’t know the first thing about it you will 

have access to shared tools made by others to 

make your workflow better, faster and stronger! 

The great thing about it is that it’s reuseable too! 

We downloaded this shared sample pack from 

Christopher Diggins: area.autodesk.com/blogs/

chris/max-creation-graph-mcg-sample-pack-for-

3ds-max-2016 and checked out the AWeld.

maxtool modifier inside. It works pretty simply – 

you have your operator WeldMesh, which in its 

description states that it “combines vertices that 

are closer than the given threshold”, and in it you 

just need to connect up the mesh and the 

threshold to define the distance of the WeldMesh 

operation. Connect it to an output modifier and 

you get it in the modifier list ready to be piled up in 

the Modifier Stack. The end result is an artist-

friendly scripting environment.  

As for the modelling workflows, the OpenSubdiv 

modifier is definitely worth a mention; it came with 

Max 2015 but has now been upgraded. The new 

view-dependent, adaptive OpenSubdiv has a GPU 

display, better support and automatically reduces 

the number of subdivs shown according to the 

Autodesk’s “Biggest Max Ever” 
brings forth Max Creation Graph, 
a new node-based creation tool

 3DS MAX 2016
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distance of the mesh from the camera – improving 

on performance.

The OpenSubdiv modifier performs the 

subdivision and smoothing actions of mesh 

objects. It also reads crease settings from 

underlying stack entries and applies them to the 

modified object. In combination with the 

CreaseSet modifier you should be able to go 

through all the edges with ease as the CreaseSet 

modifier lets you make layers of different crease 

intensity to all of the crease edges.

Another new option is Dual Quaternion 

Skinning, which will avoid undesirable deformation 

and artifacts due to any folding of the mesh as this 

can cause the volume of the mesh to lose its 

shape. You can now paint the weights for the Dual

Quaternion weight map (black and white), and 

paint tools can be used where necessary (most 

likely for a character’s shoulders and wrists). 

XRef has also gotten a lot improvements, and it 

now supports scenes with animation much better

than before. You can edit materials and lights in a 

nondestructive way without changing anything in 

the master scene!

Meanwhile Iray has been greatly enhanced in 

Max 2016 – Iray Light Path Expressions, for 

example, can isolate lights and objects based on 

layer name for easy lighting control. Iray is now just

a click away from the perfect render. 

Darijan Kalauzović

FAR LEFT This model and rig, which has been named Gsuit,
was made to see how a rig acts with a high-poly model

LEFT On the left blend shape of the modifier, you paint a black
and white image for the Dual Quaternion, and on the right is
the mesh result when rotating the bone more than 360 degrees

ABOVE Gsuit’s detailed chest piece and materials

MIDDLE LEFT In this image we presented how the MCG works
by exposing the node base connections for the AWeld.maxtool

BOTTOM LEFT Here we can see the different subdivision
modifiers andhow they work to make the end result

 Max Creation Graph… will 
no doubt help out the whole 

community in building
procedural scripts and tools

for 3ds Max 2016  

Verdict

Summary

One of the better releases of 3ds Max in quite a while, 

the Max Creation Graph is really going to make  

everyday tasks a lot easier

Price   £186 inc VAT / $185 per month,  

 £1,488 inc VAT / $1,470 per year

Stand-alone Licence price   £3,100/$3,675

Website  autodesk.com

OS  Windows 7 (SP1), Windows 8  

and Windows 8.1 Professional 

CPU  64-bit Intel or AMD multicore processor 

RAM  4GB (8GB recommended)

Disk space  6GB

Mouse  Three-button

Essential info

Features

Performance

Design

Value for money
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Overclockers 
RENDA 
PW-E7F

R
ENDA is a new workstation brand from UK 

component vendor Overclockers. It’s one of 

the biggest retail rivals of Scan Computers, 

whose 3XS line of 3D systems has consistently 

impressed us, with some of the fastest 

workstations we’ve tested. A high standard for 

RENDA to meet, but from initial impressions, from 

the packaging to the build quality, the PW-E7F is a 

fi rst step in the right direction.

The RENDA line-up consists of entry-level and 

mid-range workstations under £1,000, with Core i5 

and i7 processors, all the way up to dual-processor 

builds. As with most vendors, there’s a 

customisation page, with the full range of AMD 

FirePro and Nvidia Quadro graphics cards available.

The default confi guration includes a Quadro 

K2000 (Quadro K620 in the less high-end 

models), 128GB SSD, and a 1TB hard disk.

The PW-E7F we received for review has a 

beefi er specifi cation though, with a FirePro W8100 

video card and eight-core Intel Core i7-5960x CPU 

which has been overclocked to 4.3 GHz. There’s a 

256GB Samsung 850 Pro SSD and a 2TB Seagate 

hard disk here too.

With these components, the retail price comes 

to just over £4,000, although the graphics card 

alone accounts for a large chunk of this price, so if 

you opt for a slightly less high-end model, you can 

save some cash.

The specifi cation very closely matches Scan’s 

3XS GW-HT20, which costs less in conparison, but 

Overclockers has managed a slightly higher clock 

speed, squeezed in a beefi er power supply and 

included 32GB of RAM in the PW-E7F. Notably, 

there’s a custom-built liquid cooling system instead 

of an all-in-one from the likes of Corsair.

An overclocked Core i7-5960x is just about the 

best CPU you can get for general-purpose 

rendering, and that’s because it off ers eight cores to 

handle multithreaded rendering jobs, but with a 

high clock speed, it will chew through other tasks 

too. Intel’s Xeon processors have their uses of 

course, and this is a chip we’d recommend above all 

others in the market.

The PW-E7F managed some great results, with 

a score of 191 in CINEBENCH OpenGL and 1717 in 

RIGHT The build quality is superb, with great attention paid to 
the cable management

This fast eight-core system from 
Overclockers is a perfect match 
for most rendering workloads

 OVERCLOCKERS RENDA PW-E7F
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the CPU test. A score of 64.96 in SPECviewperf’s 

catia-04 test is identical to Scan’s machine while 

the 1196 LuxMark OpenCL result is just a bit higher, 

and this of course refl ects the small processor clock 

speed diff erence.

In 3ds Max the Underwater test was completed 

in 1 minute 50 seconds at VGA resolution and 6 

minutes 46 seconds at 1080p. Xeon processors 

normally storm ahead in this test, but while the 

PW-E7F was outgunned by workstations like 

Lenovo’s P900, with dozens of CPU cores, it’s still a

great result to be had.

Generally then, this is a perfect confi guration and

specifi cation for most people, and will therefore 

satisfy the needs of most artists. 

Orestis Bastounis

ABOVE The Nvidia Quadro K5200 in the ThinkStation can be 
added to the PW-E7F for empowered performance

ABOVE The custom-built liquid cooling system looks fantastic
and is very powerful

ABOVE Although it’s not exactly cheap, 
the high-end hardware makes the PW-E7F good value for money

RIGHT Phanteks’ stylish yet simple cases maximise cooling potential 
and are used for all water-cooled RENDA workstations

 Overclockers has managed 
a higher clock speed, squeezed

in a beefier power supply and
included 32GB of RAM  

Verdict

Summary

Well built, superb performance and great for 3D.  

Overclockers knows what it’s doing

Price   £4,114 inc VAT

Website  overclockers.co.uk/LP/renda.php

CPU         Core i7-5960x overclocked to 4.3 GHz 

RAM  32GB DDR4

GPU  AMD FirePro W8100

SSD  Samsung 850 Pro

Storage  Seagate 2TB hard disk

Cooling system  EK water blocks and radiator

Essential info

Features

Performance

Design

Value for money
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Substance Designer 5

S
ubstance Designer 5 has been released to 

quite a fanfare. Allegorithmic declared that 

this was the #yearofPBR back in January and 

backed that up with some excellent physically 

based rendering guides and updates to sister 

package Substance Painter. We were eager to see 

what had become of the package that introduced 

us to Allegorithmics texturing philosophy. 

For those unfamiliar with Designer it uses a 

node-based system, compiling the texture through 

various inputs and functions in the form of graphs 

which output all common real-time maps for both 

a metallic or roughness one and a specular or gloss 

workfl ow. Outputs can be customised to combine 

maps into RGBA channels too, depending on what 

your target renderer requires. Alternatively several 

game engines now have Substance support, 

enabling you to output your graphs directly to the 

engine, and this opens up the possibility of 

exposing parameters within the graph that can be 

changed or adjusted in engine, from simple eff ects 

such as colour changes, through to complicated 

wear-and-dirt compositions.

SD5 is more a refi nement than a game changer. 

There are some new nodes available, such as 

Tri-planar mapping, which should see an end to 

seams in imported grunge maps, and the pixel 

processor, which will enable the more technically 

inclined artist to create per pixel functions. The 

early iterations of PBR-specifi c nodes, available in 

the later Substance Designer 4 updates, have 

made a more polished appearance in this release. 

Additionally the blend node now has several extra 

Photoshop-familiar blend modes included with it.

We took a simple character clothing asset 

through the Substance workfl ow, utilising its 

built-in baker. The software can generate the full 

spectrum of real-time maps, from Normal and AO, 

(either from mesh or GPU-based) through to the 

less commonly used position (world space 

gradient) and thickness maps. This really is an 

excellent feature and great for revisions, or if 

additional maps are needed for the various 

procedural wear-and-dirt generators that 

Substance comes with. 

The baker itself is both fast and accurate using 

either distance-based ray cast or cage baking. It 

didn’t however warn us of a broken cage in the way 

Is the latest iteration of the node-based procedural texture generation 
software worth the upgrade?

ABOVE The new Tri-planer node enables 
seamless texture wrapping for any bitmap 
on your chosen mesh

 SUBSTANCE DESIGNER 5
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that XNormal would, but that’s the only fault we 

could find with it and this was soon fixed once we 

viewed the Normal map generated in Substance’s 

own 2D map viewer.

When using the procedural wear nodes it took 

quite a bit of slider exploration to get a result that 

we were happy with, sticking with very low values. 

For a simple test we were pleasantly surprised by 

the out-of-the-box options, but they do feel a little 

hit and miss at the moment, and are probably 

more suited to hard surface objects than organic 

pieces such as characters. We tried exporting our 

resultant graph out to Substance Painter, hoping 

that it would keep the graph structure so that we 

could detail the texture. Unfortunately it exports 

the graph as a flattened image, something that we 

hope Allegorithmic can address in the future.

Aside from texturing standalone meshes, the 

other string to Substance Designer’s bow lies in 

the creation of procedural tiling materials.

These are created through the use of generators

(greyscale patterns essentially) and functions, the 

latter of which contain everything from tiling and 

offset nodes through to common blending modes,

and transform options. With this in mind we 

thought that we would try our hand at a procedural

wood texture. The learning curve for this becomes

quite steep, there are rollover tooltips that provide 

a brief outline of a node’s uses, but we did find 

ourselves referring to the internet as Allegorithmic

and various YouTube users have graciously 

uploaded tutorials which explain uses in a little 

more depth and show the possibilities available. 

The new Dynamic gradient node was 

particularly useful, as it enables you to create a line

across any image which maps the RGB value 

underneath to a gradient with adjustable precision.

It gave us some great tonal variation, perfect for 

the woodgrain that we wanted to achieve. 

Seth Nash

TOP LEFT Some graphs can become complex, but SD’s clean
UI keeps everything understandable

BOTTOM LEFT With a few hours spent going through tutorials
you can achieve some excellent engine ready procedural
textures for your projects

BELOW A basic jacket asset baked and textured inside
Substance. We were impressed with the baking options

 There are some new nodes 
available, such as Tri-planar 

mapping, which should see an
end to seams in imported

grunge maps  

Verdict

Summary

Once you have the basics down, it becomes a powerful 

texture generation tool

Price   £109.99 (indie) inc VAT, £449.99 (pro)  

inc VAT / $149 (indie), $590 (pro)  

Website  allegorithmic.com

OS  Windows 7 / Mac OS X 10.8 and up

RAM  4GB recommended 

Free space  1GB recommended 

Processor  X86 with SSE2 recommended

Graphics (Windows)  Minimum DX10 capable 

Essential info

Features

Performance

Design

Value for money
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iClone6
Bypass object creation and rigging, and get straight into
the animation process with the latest Reallusion tool

 ICLONE 6

R
eturning with a signifi cant upgrade to its 3D 

animation production tool, Reallusion’s 

iClone 6 has been almost completely 

revamped to off er its users the most streamlined 

iClone experience yet.

What iClone 6 lacks in object modelling tools it 

makes up for with a considerable amount of 

embedded content, now boasting improved 

functional and visual quality since the upgrade. 

Playing around with these prepacked objects is a 

great way for newcomers to get used to the 

program. Setting up a scene using the preset 3D 

‘stages’ and ‘actors’ in iClone 6 can feel a little like 

putting together a house in The Sims, but the 

potential for producing high-quality work with little 

time and eff ort is immediately apparent.

Everything about iClone 6 is built for making 

work of high quality in as little time as possible. It 

has reduced many of the more complicated 

procedures required for sliders or simple button 

clicks, and shader set-up is now even faster than it 

ever has been before. 

iClone will autoconvert all imported real-time 

materials and lighting data into a physically based 

format compatible with ray tracing capabilities. 

Furthermore, if you’re not satisfi ed with the visual 

quality of your object, surface smoothing can be 

applied to increase the surface detail of low-poly 

models with the click of a single button. It includes 

support for industry standard technologies, such as 

the updated Unreal Engine, as well as Indigo RT, 

which enables users to work in hi-res cinematic 

quality in real-time – very handy for increasing 

production speed. 

iClone 6 fully supports importing objects from 

programs such as ZBrush and Maya; combine this 

with Indigo RT to work with your objects in full 

cinematic quality without the need to prerender. A 

veritable arsenal of tools are available for iClone 6: 

SpeedTree, Softcloth, DirectX 11’s Tessellation, a 

mo-cap plugin – the list goes on!

Its applications are vast and varied: pre-vis, game

asset creation, TV production; meaning boundless

potential for creating full scenes from separate 

imported objects, which could then be exported to

Photoshop and used as drawing reference. 

iClone 6’s simplifi cation of functions is exactly 

what makes it so accessible to 3D newcomers, and

so useful for experienced users. It’s not a 

replacement for more sophisticated animation tools

like Maya, but users interested in producing 

high-quality animation without the need to create 

content from scratch will get a lot out of iClone 6.

Rebekka Hearl

Verdict

Summary

Streamlined and uncomplicated, iClone 6 is a great 

animation tool for beginners and advanced users alike

Price   $99 Standard / $199 Pro

Website  reallusion.com

OS  Windows only 

CPU  Dual core CPU or higher

RAM  4GB

HDD space  5GB

Display  1024 x 768

GPU  Nvidia GeForce GTX 400 Series / AMD 

Radeon HD 5000 Series

Essential info

Features

Performance

Design

Value for money

ABOVE The animation interface and 
timeline are uncomplicated and easy to work with. 

Alternatively, you can apply premade animations 

BELOW iClone 6 comes with a library of premade 
objects, animations, sounds, and even shaders. If you 
fi nd it lacking, you can download more content online
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Figuromo

Écorché 
Assistant

Collect and modify the world’s 
best 3D models as digital figurines 
with the new app collection

If you’re interested in human 
anatomy for modelling or 
animation, this is the app for you

I
nspired by the collectible figurine market, 

Figuromo Studio LLC has created a whole new 

way to display high-end 3D sculpture on an 

iPhone or iPad after working with famous CG 

A
lready talked of as being better than a pile 

of anatomy books, Écorché Assistant is 

certainly an app on human anatomy that 

has gotten the industry’s attention. Even legend 

Rick Baker has described it as the most thorough 

app he’s ever seen. This comes as no surprise as 

the creator behind Écorché assistant, Alexander 

Kafoussias, is a graduate of the sculpture program 

at the Florence Academy of Art.

Though currently only for male anatomy, the app

goes into an astounding level of detail in a clearly 

organised visual way. On the main homescreen, 

you can choose between a model showcasing the 

muscular system, one showing the skeletal system,

and a representation of the body’s proportions to 

delve further – even giving you the ability to rotate 

the models with your finger to be able to see (and 

replicate) the muscles and skeleton from every 

angle. The only pity is the fact that you can’t close 

up on these rotatable models to be able to look at 

details when you’re sculpting anatomy in 3D, for

example, though it’s an option that we imagine will

be added in later versions.

Once a model is selected, you’ll be able to see

details of the human skeleton and muscle structure

at an almost medical level, with every muscle

named, cross-sections of the body shown close up,

and even the ability to see muscle actions and what

bones and muscles are responsible for different

movements. This would not just be excellent for

anyone hoping to become a great 3D modeller, but

for animators as well.

Larissa Mori

artists around the world in a 50 per cent profit

sharing agreement. The ultimate result is a series

of apps that let you actually modify incredible

industry 3D character models on Figuromo for

£0.59 on Android and £0.79 on Apple devices.

If you’d like to take a closer look at our former

cover artist Aldo Vicente’s Caballero Royal piece

from issue 68, for example, all you need to do is

download his Figuromo Castle Gatekeeper Knight

app. From there, you can choose from four different

views of the posed model to then see it close up in 

a very user-friendly UI menu. Here, you can rotate 

the model, though not by a full 180 degrees, and 

individually select areas such as the feet, head and 

accessories to then modify materials and textures 

with a variety of options.

Despite the lack of support for the iPad’s touch 

functions to be able to zoom in on the model easily

with our fingers, within minutes we had easily 

created our very own version of Aldo’s piece and 

had a lot of fun changing the colour from an 

impressive palette of light and dark tones, as well as

the finish from matte to more shiny on many 

different parts of the knight before saving our 

creation. This is an excellent way to introduce 

younger children to the idea of 3D artwork – 

something Figuromo Studio LLC has certainly 

acknowledged with the release of the Figuromo 

Kids apps, specifically catered towards them.

Larissa Mori

Verdict

Verdict

Summary

Summary

We can see why so many in the industry are giving this

anatomy app a lot of attention!

A great introduction to 3D art for kids – and a great 

way to collect some of the best 3D models as digital 

figurines for adults

Price £10.99 / $14.99

Website ecorchebyalexander.com

OS iOS 6.0 and up. Compatible with iPad

Version 1.2

Size 684MB

Language English

Price    £0.79/$0.99 per app on iTunes / from 

£0.59/$0.99 in Google Play 

Website  figuromo.com

OS   Android OS 3.2 / iOS 6.0 and up (optimised 

for iPhone 5, iPhone 6, and iPhone 6 Plus) 

RAM  512MB

Size  From 32MB for Android / from  

45.2MB for iOS

Essentialinfo

Essentialinfo

Features

Performance

Design

Value for money

Features

Performance

Design

Value for money

ABOVE Écorché assistant includes a full overview of the male 
proportions including skeletal and muscular system. Each 
muscle is shown in detail including origin, insertion and action 

RIGHT Muscle layers are also shown in order for when 
designing écorché in clay

MAIN Change the colour 
and material settings of 
your model from an 
impressive palette 

LEFT Figuromo apps are 
inspired by the collectable 
figurine market

ÉCORCHÉ ASSISTANT & FIGUROMO   
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WarrenTrezevant,product manager for
Maya animation and rigging at Autodesk

 Our target was to try to get it three 
times faster so something that would 
have played at ten frames per second 

would now be playing at 30  



B
ill Gould has been in business for 42 years as a model 

maker, ”I started when I was 12-years-old,” he begins. 

But Bill got sidetracked after high school, initially getting 

into set design before working so much he burnt out and left 

the industry completely – only to start working on 

modelmaking once again. A few years later, Gould had 

opened his very own business.

Incredible opportunities began to become a reality, like 

getting to work with the great Henry Dreyfuss: considered 

by many to be the father of industrial design. “Dreyfuss did 

all of the big stuff,” Gould remembers. “He designed the 

standard domestic telephone, designed the Polaroid 

cameras, you name it, and I was very fortunate to 

work with him.”

In the year 2000, however, things changed in a 

way Gould could have never predicted. “Rapid 

prototyping really started up and literally within six 

months my model-making business just went through the 

floor,” he reveals. “I was absolutely slamming to keep my 

business going because the problem was I could do a model 

and it might take three or four weeks and cost say $2,000 

(£1,338) at that time in those dollars, but with rapid 

3D printing $40,000 
model cars
Designers Bill Gould and Brian Yingling tells us how 3D 
printing has revolutionised perfect miniatures

prototyping they could get the same thing done in three days 

for $500 (£334).

“I talked to my clients and they all agreed that I should get 

into SOLIDWORKS, get into CAD. So I went to college at 

night for two semesters, I took SOLIDWORKS beginning and 

advanced classes. I sold my drafting table machine and sold 

all my machinery. I’m now strictly a designer, and it’s proven 

to be a very good choice.”

For Brian Yingling, who first started creating his own 

miniature museum-quality car models over 20 years ago, 

adapting to additive manufacturing and 3D printing was also 

a part of keeping his business going. “It’s really been kind of 

three major transitions,” he tells, “one was just to do it all by 

hand, the second one was creating 2D drawings with 

AutoCAD and being able to take advantage of the CNC 

machines to bring them into reality, and the third step which 

is where I am now is actually drawing the entire car in 3D 

software and then sending that to a 3D printer.”

The process begins with research for blueprints and 

information on how the vehicle was built: crucial for 

producing the level of detail needed in Gould and Yingling’s 

final creations, which will even have miniature leather seats 

for the visual accuracy required. Next comes the modelling. 

“I use 3ds Max to create my models,” says Yingling. “You 

have to remember that the parts definitely have to fit 

together like a puzzle, there’s no question. The more accurate 

you are in your 3D the easier it will be for assembly later. You 

need to think about the tolerances of how things fit together 

– or else you’ll be doing a lot of hand work like sanding it or 

filing it to make it fit the way it’s supposed to fit.”

The finished Miller 91 by Bill Gould and CIDEAS. Gould had to thicken up 
all the walls of his original model of the Miller 91, then redesign the model 
so that it would print to scale in four different rapid prototyping processes

ABOVE The Cadillac was developed
over the course of eight months, and

created with the use of over 95 per
cent 3D printed parts

 COMMUNITY NEWS
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“You even have to build in allowances for paint thicknesses

and allowances for plating, you kind have have to know the

accuracy of SLS vs SLA and you have to build those in,”

explains Gould. “I always make sure I do my designs in a way

that I could always come back and modify the wall

thicknesses easily, for example – that’s one of the most

important things to make pieces strong enough.”

For both the designers, collaborating with Additive

Manufacturing and 3D printing centre CIDEAS has become

the way they bring their 3D printed designs to life. “They are

one of the few companies around that has the ability to print

very large pieces,” says Yingling. “I could sometimes print the

entire car body in one print with CIDEAS as opposed to

printing it in pieces and having to make it like a puzzle to put

together later.” The collaboration led to the two projects

Gould and Yingling are most proud of ever having created: a

Miller 91 miniature and a scale Cadillac with 95 per cent of

its parts 3D printed.

After printing, parts like the bumpers and door handles will

be sent out to a chroming shop to be chromed while

elements like the hub caps of the wheels will be sent out to 

another company that does brass casting. “That’s usually 

what takes the longest amount of time,” Yingling continues. 

“It’s typical – the chrome shop takes six to eight weeks 

before you actually get some parts back. But there are many 

things that can be done while you’re waiting for that, like 

finishing the body work and paint, and upholstering the 

seats.” Ultimately, the final miniatures created can cost 

anywhere from $3,000 (£2,009) up to $40,000 (£26,795).

For anyone interested in following in their footsteps for the 

future, Gould has one important lesson to remember: one he 

learned from his time working with Dreyfuss in the early 

Seventies, before the great designer committed suicide. 

“That’s a long story and it’s a sad story,” he concludes, “but 

I’ll always remember at a conference for one of our huge 

clients he made the most amazing comment: he said ‘To 

design for the future, we must understand our past’, and I 

thought, ‘He’s absolutely right.’”

I could sometimes print the entire 
car body in one print with CIDEAS as 

opposed to printing it in pieces
Brian Yingling, hand-built model car specialist, 

product designer and computer artist

ABOVE Yingling with his newly 
finished Ford Mystere. Every detail 
– including the upholstered seats – 

can be seen in the model cars

RIGHT Work in progress on Gould’s 
1927 Miller 91 model car. It was 
created using all four major 3D 

printing processes in just six weeks 

BELOW Yingling’s Scale Buick show 
car that is a sixth of the scale. It is in 
the process of being built using 3D 

printed parts with CIDEAS

www.3dartistonline.comGet in touch… @3DArtist Facebook.com/3DArtistMagazine
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N
ow available to buy as a perpetual licence as

well as rental for the very last time, Autodesk

has unveiled the brand newMaya andMax

2016 – two updateswith a host of exciting features.

ForMaya, users will get huge improvements in

animation performance due to a new parallel

evaluation system that takes advantage of both the

CPU and theGPU, ultimately increasing the speed of

both playback and character rigmanipulation.

Modellers will also see a change: the Autodesk team

has now partially integratedMudbox tools and

capabilities straight intoMayawith a brand new

sculpting toolset. This will include brushes that feature

volume and surface falloff, stamp images, sculpting

UVs and support for Vector Displacementmaps.

Meanwhile, 3dsMax users will be able to get their

hands onwhat Autodesk is calling “The BiggestMax

Ever” with 3dsMax 2016. Two different products, 3ds

Max and 3dsMaxDesign, are nowmerging into one

single 3dsMax that can bemuchmore tailored to an

individual’s needs. The newMaxCreationGraph is

another impressive feature. Integrated by user request,

it’s a node-based tool creation environment that

enables anyone to extendMax’s capabilities by

creating new tools and visual effects through the

connection of several hundred different node types.

We can’t wait to seewhat people create!

HAVE YOU HEARD?  Luxion has announced the building of new corporate headquarters due to continued growth of the company

Maya and 3ds Max 
2016 released
New features include a sculpting toolset from Mudbox, a 
Max Creation Graph and more!

A gift for 
compositors

Explore the tool that the best VFX artists use to 
composite, edit and finish using The Foundry’s
new NUKE Non-commercial release

The Foundry introduces 
MODO 901 and a brand 
new free version of NUKE
It’s certainly been a very exciting time 

for The Foundry so far this year. Over 

the space of just a few weeks, the 

company announced both an exciting 

new MODO 901 and NUKE Non-

commercial, a totally free, 

nonwatermarked version of the entire 

NUKE product family, with some light 

functional restrictions, for anyone who 

wants to learn the professional 

compositing solution without having to 

pay in the thousands.

“We’re committed to investing in the 

future of VFX and the talented artists 

who continue to astound us with the 

content and experiences they create,” 

said Philippa Carroll, head of media 

production, business strategy and 

operations. “By opening the whole 

NUKE range to the widest audience, 

people interested in personal learning 

and projects, experimentation or 

research can use the same solutions 

used by some of the most talented VFX 

artists across the globe.”

Learn more about the new NUKE 

Non-commercial at thefoundry.co.uk/

products/nuke/non-commercial, and 

see all of MODO 901’s features at 

thefoundry.co.uk/products/modo/

latest-version.

Faster animation: how it works
Warren Trezevant, product manager for Maya 

animation and rigging says: “One of our biggest 

challenges is clearly understanding what our 

customers need and making sure we deliver 

the value they want that will get their work 

done more easily, intuitively and faster.”

“The parallel rig evaluation [and] the 

multithreading of Maya, was a huge 

improvement… We’re also providing a profiler, 

which will allow our users to see how Maya is 

evaluating their scene, and make tweaks to 

make Maya even faster. Our target was to try 

to get it three times faster so something that 

would have played at ten frames per second 

would now be playing at 30.” 

Buy or rent Maya and 3ds Max 2016 at 
autodesk.co.uk/products/maya/buy and 
autodesk.co.uk/products/3ds-max/buy

 INDUSTRY NEWS



New research shows how printing
technology could produce soft
robots and flexible electronics
Soon 3D printing with liquid metal might very well

be possible, according to research from Purdue

University, Indiana.

Because liquid metal in its native form is not

print-friendly, liquid metal nanoparticles are created

by dispersing the liquid metal in a nonmetallic

solvent using ultrasound. This process makes them

small enough to pass through a typical inkjet printer

nozzle sucessfully.

According to the researchers, the tech could help

introduce a whole new class of pliable robots,

enabling these robots to squeeze through small

spaces, for example.

Liquid metal printing could also lead to the mass

production of stretchable garments that people

would wear so that they can physically interact with

computers for the first time.

Pixologic has unveiled the offi  cial 
dates and details of this year’s 
offi  cial ZBrush event
After a very successful ZBrush Summit last year, 

which gave artists a specially created free event 

aimed at users of the digital sculpting package for 

the very fi rst time, Pixologic has just revealed that 

they are now all set to reveal details of the ZBrush 

Summit 2015 via a blog post. 

The event, which will take place from the 25-27 

September this year, will once again be held on the

grounds of LA’s prestigious Gnomon School of

Visual Effects for what Pixologic is calling the

ultimate ZBrush experience. Attendees will be

treated to a variety of dynamic presentations and

panel discussions over the three days, including

on-site workshops, a live ZBrush Sculpt-Off

Championship amongst some of the best digital 

sculptors today, and the fi rst ever ZBrush Awards.

ZBrush Summit 2015 will also be streamed live 

– with exclusive competitions that can be entered no 

matter if you are watching in LA or at home.
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Next Limit announces the latest
edition to its award-winning
RealFlow portfolio
In an exciting move for Cinema 4D users

everywhere, Next Limit has announced RFCORE

for Cinema 4D, giving all users the ability to

access the industry standard fluid simulation

software, RealFlow, right from inside of Cinema

4D itself, without the need of learning a new

interface or having to move files between

software applications.

“We are very excited about RFCORE|C4D,”

said RealFlow Product Manager, Gustavo

Sanchez. “We work a lot with the C4D

community and understand that, for some

artists, RealFlow might seem a little daunting.

Therefore we are pleased to present them with

a solution which will allow them to access

high-quality RealFlow fluid simulations from

inside their 3D package.”

The team have also mentioned that this

upcoming release of RFCORE will open up the

possibility for other RealFlow integrations,

making the fluid simulation software accessible

to many more artists for the future.

DID YOU KNOW?  Pacifi c Rim 2 has been announced, and Guillermo del Toro is returning to direct the action-packed sequel

Bringing you the lowdown on product updates and launches

RFCORE for Cinema4D

Liquid metal
could change 3D
printed robots

ZBrush Summit 2015

Software shorts
Isotropix Clarisse iFX 2.0
After fi rst being announced in 

August last year, Isotropix is now 

shipping Clarisse iFX 2.0, its next-gen 

2D/3D rendering tool, which is the fusion of an 

animation package, compositing software, and 3D 

rendering engine. Prices start from $999 (€849) 

per licence for freelance artists and $1,499 (€1,299) 

for a licence for a small studio with up to fi ve artists.

Shotgun 6
Shotgun Software has unveiled the 

new Shotgun 6, which features new 

project templates, enhanced 

navigation and browsing, improved Flame 

integration, and the ability to work together with RV 

6 without any required end-user confi guration. You 

can download the software from $30 (£20) per 

account, per month.

Fusion 8 and Fusion 8 
Studio for Mac and Linux
Blackmagic Design has announced 

that Fusion 8, its advanced visual 

eff ects and motion graphics software, will be 

released on Mac OS X and Linux for the very fi rst 

time. Fusion 8 will be available free of charge from 

the Blackmagic Design website, while Fusion 8 

Studio will be available for $995 (£655.55).

Register your interest to stay in the loop with upcoming
announcements at summit.pixologic.com

An artistic render of how soft, fl exible circuits and electronic 
devices could be printed to provide stretchable garments that 
let us interact with computers

Though the exact release date hasn’t yet been announced 
for the new RealFlow integration, Next Limit have said that 
RFCORE|C4D is scheduled to be out later this year
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Job Co-founder of Unity 
Technologies

Website unity3d.com

Location Copenhagen

Biography David’s background 
is as a programmer. Along with 
co-founders, Nicholas Francis 
and Joachim Ante David, he 
went on to found Unity 
Technologies, and then served 
as its CEO for 12 years. He now 
combines his understanding of 
technology and business to 
figure out how to create 
enduring businesses around 
great technology and teams.

Portfolio Highlights

2014-present  Realm

2012-present  QuizUp

2003-present  Unity

 INDUSTRY INSIDER
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05 06

We talk to the game engine 
mastermind about game 
development and democratisation

David Helgason
Co-founder of Unity Technologies

U
nity was born 11 years ago – a game development 

engine with hopes to turn every bedroom coder into a 

fully fledged developer. Now, its fifth iteration has been 

released, bringing with it a whole raft of new features that will 

enable even more game creators to bring their ideas to life. We 

met with David Helgason, one of the original founders of Unity, 

to find out just how the system has gotten to where it is today.

What kind of work were you doing prior to Unity?

Before Unity I started a few companies, but none of them ended 

up taking flight or even really mattering.

Can you tell us how Unity as a concept came about? What 

experiences led you to the thinking behind Unity?

Unity (the company) was formed by the three of us founders 

coming together to make games. We first worked on an engine 

for our own use, but over a couple of years we decided that we 

were really more passionate about the technology.

Unity (the software) really came about to solve the problem 

that Unity as a concept didn’t exist yet. There was no readily 

available software we could use. The software that already 

existed was too expensive and too unwieldy for a small team. 

Even before Unity was a ‘thing’, we had a sense that we were 

onto something. We looked at the history of other creative 

mediums, and noticed that easier and more efficient tools had 

helped revolutionise both the film (digital cameras and editing) 

and earlier music (the home studio) industries. 

So, based on that, our elected mission became to 

‘democratise game development’. What we took that to mean 

was to provide better, easier and cheaper tools, and thus make 

more people able to participate in game creation than before.

How different is Unity today to the vision that you first 

had? Has it changed in ways that you weren’t expecting?

Unity’s insanely better than in those old days, but overall it’s the 

same thing: a great tool that makes game development that 

much easier and better. And the goals of the company remain 

the same: to make the game industry bigger and better and to 

make more developers successful than ever before. This 

includes massive upgrades to the graphics and performance in 

Unity 5.0 (and more updates in the next point releases). 

Are there any elements you want to add to the engine 

that you have not yet had the opportunity to work on?

We have been working on making Unity even better for artists 

and designers. In Unity 5.0 we made the lighting and shaders so 

that it’s really easy to get your art to look fantastic.

What excites you most about the independent gaming 

scene? What games have really impressed you?

I love the richness and the creativity of independent gaming. Ori 

And The Blind Forest, Kentucky Route Zero, and Cities: Skylines 

are all proof that tiny teams can make big things happen!
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01  Unity came at just the right time: just as smaller, 
more casual smartphone games were coming to 
prominence. These apps started a golden age of 
independent game development, and Unity was 
there to ride the wave

02  Helgason was CEO of Unity Technologies until 
2014, at which point he stepped down, with 
Electronic Arts’ former CEO John Riccitiello 
replacing him. Helgason has remained at the 
company as executive vice president

03  Although Unity has grown more powerful over the 
years, Helgason says that the core ethos behind the 
software hasn’t changed: giving more people the 
power to become successful game developer 

04  Unity was founded by Helgason (far left), Nicholas 
Francis (far right) and Joachim Ante (second to 
left). They were hoping to create an easy-to-use 
and affordable game development tool

05  The recent release of Unity 5.0 has introduced 
many powerful new features, such as a physically 
based shader, real-time global illumination, HDR 
reflection probes and PhysX 3.3

06  Unity has been used to create a huge amount of 
incredibly successful games. Some recent 
examples include Ori And The Blind Forest, Alto’s 
Adventure and Monument Valley

 The goals of the 
company remain the 

same: to make the game 
industry bigger and better 

and to make more
developers successful
than ever before  

“There’s no slowdown [for the 

games industry] in sight. The 

universe of people who play 

games is only growing, and both 

PC and mobile games are 

growing by leaps and bounds. 

“Unity is getting better all the 

time, and with our free Personal 

Edition (which you can make 

money with) even more creative 

people can get started than ever 

before. The future looks bright 

for those who love games.”

Levelling the 
playing field
Helgason discusses the 
expansion of the ever-
growing games industry
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Images of the month
Theseare the3Dprojects thathavebeenawarded ‘Image
of theweek’on3DArtistOnline.cominthe lastmonth

01

02

01We Are Back
byPaul Flower
3DAusername
ouroboros888
Paulsays: “I was inspired

by Scuderia Ferrari’s winning return
and SebastianVettel’s first win for
the team.My aim is to portray a
balance between detail and
movement in this 3D scene.”
Wesay: It was great to see Ferrari
return to its winningways inMalaysia,
and Paul has captured themoment
that SebastianVettel crossed the line
perfectly. The reflections are superb.

03 Loft IT office
interior design
byDimitar Ivanov
Gongalov
3DAusername

dg_architect
Dimitarsays: “The set of images
that this particular image is from
are part of visualisations generated
to presentan office furniture
company’s products.”
Wesay:We’re suckers for great
interior arch-vis.We really like how
crisp and clean everything is and it has
been brilliantly lit aswell.

04Abandoned
Mercedes
byRoryBjörkman
3DAusername
RoryBjörkman

Rorysays: “I’m interested in the
textures formed by decay over
time. In this image I’ve decided to
render an abandonedMercedes. I
like to think it was once somebody’s
pride and joy.”
Wesay:There’s a palpable
authenticity about Rory’s image – it
could be a photo of an abandoned car
in a postapocalyptic war zone.

02 Img-5
byKrit Suppaudom
3DAusername
MaipaiSuppaudom
Krittsays: “Thiswork

was created in ZBrush, KeyShot and
Photoshop. I really enjoyedworking
on this character and found it
extremely interesting to create the
textures. I was very satisfiedwith
this robot.”
Wesay: It’s plain to see howmuch
attention Krit has paid to texturing his
droid – it has a real worn-out,
abandoned look to it.
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Share your work, view others’ and chat to other artists, all on our website

Register with us today at www.3dartistonline.com



Bloodshot by Brandon Kynoch
3DA username Brandon Kynoch
Brandon says: “A small photorealism/nature project that I 
started so that I could really test my skills with Blender and 
Photoshop. I’ve really enjoyed working on it and it’s come a long 

way from concept to fi nal image.”
We say: Brandon is only 13 and has only been using 3D software for a little while. 
We love the detailed foliage and can’t wait to see how Brandon’s skills develop!

Alley at noon by Syed Vaseem Haider
3DA username Arshi
Syed says: “I was always mesmerised by this alley, where the 
sunlight on the rough surface refl ects and makes everything look 
very beautiful.”

We say: Syed has succeeded in creating a fantastic rustic atmosphere and has 
used texture to great eff ect. We could easily imagine strolling down this alley. 

Paul by Daniele Boldi Cotti
3DA username dboldicotti
Daniele says: “The inspiration came after a trip to the French 
Riviera. The main idea was to use a Pixar style, mixing diff erent 
software – 3ds Max, Marvelous Designer, Dreamscape, 

Mudbox, Vue, V-Ray and Nuke – to get the best result.”
We say: This is a great scene that has been beautifully framed. Daniele has done 
a great job of creating believable water, while creating an abstract, cartoon scene.

Mazda CX5 Interior by Johnny Grilo
3DA username square01
Johny says: “At my company I work a lot with car commercials, 
and creating interior views are always welcome – they’re full of 
details and it’s fun to watch light interact. Using V-Ray I could 

render accurately without spending too much time on shaders and tweaking.”
We say: We can tell from the fi rst glance that Johnny is a pro when it comes to car 
interiors – this could just as easily be a photo!

03

04
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YOUR FREE RESOURCES
Log in to filesilo.co.uk/3dartist and download your 3D resources NOW!

YOUR BONUS 
RESOURCES
ON FILESILO THIS ISSUE, FREE AND 
EXCLUSIVE FOR 3D ARTIST 
READERS, YOU’LL FIND OVER 7GB 
OF RESOURCES, INCLUDING…

25 3DTotal textures

CGAxis models

THISMONTH’S
COMBINED
RESOURCESIZE: 7GB

4+ HOURS OFDIGITALTUTORS VIDEOS

EVERYTHING 
YOU NEED 

TO FOLLOW 
ALONG WITH THE
MAGAZINE AND
CREATE GREAT

3D ART

Humster3D models
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FILESILO–THEHOMEOFPRORESOURCES

A rapidly growing library 
Updated continually with cool resources
Lets you keep your downloads organised
Browse and access your content from anywhere
No more torn disc pages to ruin your magazines

No more broken discs
Print subscribers get all the content
Digital magazine owners get all the content too!
Each issue’s content is free with your magazine
Secure online access to your free resources

Discover your free online assets

The most popular downloads are shown 
in the carousel here, so check out what 
your fellow readers are enjoying

Green open padlocks show the issues 
you have accessed. Red closed padlocks 
show the ones you need to buy or unlock 

Find out more about our online stores, 
plus useful FAQs such as our cookie and 
privacy policies and contact details

If you’re looking for a particular type of 
content, like software or video tutorials, 
use the filters here to refine your search

Can’t find the resource you’re looking for 
in these filters? Click on More Types to 
specify what kind of resource you want

Top Downloads are listed here, so you 
can get an instant look at the most 
popular downloaded content

Check out the Highest Rated list to see 
the resources that other readers have 
voted for as the best

Discover our fantastic sister magazines 
and the wealth of content and 
information that they provide

The first time you use FileSilo, you’ll need 
to register. After that, you can use your 
email address and password to log in

This is the new FileSilo site that replaces 
your disc. You’ll find it by visiting the link 
on the following page
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HOW TO US
EVERYTHING YOU NEED TO KNOW ABOU
ACCESSING YOUR NEW DIGITAL REPOSITO

Having trouble with any of the techniques in this issue’s tutorials? Don’t know how to make the
best use of your free resources? Want to have your work critiqued by those in the know? Then
why not visit the 3D Artist Facebook page for all your questions, concerns and qualms? There is
a friendly community of fellow 3D artists to help you out, as well as regular posts and updates
from the magazine team. Like us today and start chatting!

facebook.com/3DArtistMagazine

NEEDHELPWITH
THETUTORIALS?

Issue82of  is on sale 17 June 2015 from GreatDigitalMags.com                      

ToaccessFileSilo,pleasevisit filesilo.co.uk/3dartist

01 Follow the on-screen 
instructions to create 

an account with our secure 
FileSilo system, and then log 
in and unlock the issue by 
answering a simple question 

about the 
magazine. You 
can access the 
content for free 
with each issue 
of 3D Artist.  

02 If you happen to be a 
print subscriber, you 

can easily unlock all the 
content by entering your 
unique Web ID. Your Web 
ID is the eight-digit 
alphanumeric code that is 
printed above your address 
details on the mailing label of 
your subscription copies. It 
can also be found on any 
renewal letters you receive. 

03 You can access 
FileSilo on any 

desktop, tablet or 
smartphone device using 
any popular browser (such 
as Safari, Firefox or Google 
Chrome). However, we 
recommend that you use a 
computer to download 
content, as you may not be 
able to download files to 
your phone or tablet.  

04 If you have any 
problems with 

accessing content on 
FileSilo, or with the 
registration process, take a 
look at the FAQs online or 
email filesilohelp@
imagine-publishing.co.uk.



When companies are looking for 
new compositors the first thing they 
look for is your knowledge of NUKE 

Astrid Busser-Casas
VFX Supervisor

NUKE Non-commercial
Your Free Personal Edition. Explore, learn, create, play.




